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FOREWORD

SCOPE OF DELIVERY

Dear Customer,
We wish you a great deal of fun and success taking photographs
with your new Leica M10 Monochrom. Please read this manual
thoroughly to familiarize yourself with the full scope of functions
your camera has to offer. You can find all information about the
Leica M10 Monochrom whenever you need it at
m-monochrom.leica-camera.com.

Before using your camera for the first time, please check that the
accessories supplied are complete.

Your Leica Camera AG

–
–
–
–
–

–
–
–
–

Leica M10 Monochrom
Camera bayonet cover
Lithium ion battery Leica BP-SCL5
Battery charger Leica BC-SCL 5, incl. mains cable and in-car
charger cable
Carry strap
Drawstring pouch for battery, charger and cables
Quick Start Guide
Test certificate
Registration card

Subject to changes in design and production.

REPLACEMENT PARTS/ACCESSORIES

Only the accessories specified and described in this manual or
by Leica Camera AG must be used with the camera (battery,
charger, mains plug, mains cable, etc.). These accessories
should only be used with this product. Third-party accessories
may result in malfunctions or damage to the product.
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Replacement parts/accessories

Please contact Leica Customer Care or visit the Leica Camera AG
website for information on the extensive range of Leica replacement parts/accessories:
us.leica-camera.com/Photography/Leica-M/Technical-Equipment

Please read the chapters “Legal information”, “Safety
remarks”, and “General information” before using your camera
for the first time. Knowledge of the content will prevent
inadvertent damage to the product, possible injuries and other
risks.
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LEGAL INFORMATION

Legal information

LEGAL INFORMATION
• Compliance with copyright laws is mandatory. The recording and
publication of pre-recorded media like tapes, CDs or other
published or broadcast material may breach copyright laws. The
same applies for all software supplied in the scope of delivery.

IMPORTANT NOTES REGARDING THE USE OF GPS
Legal restrictions on use
• The use of GPS and associated technologies may be restricted
in some countries or regions.
• You should therefore contact your travel agent or the embassy of
your destination country for relevant information beforehand.
• The People's Republic of China and Cuba (exceptions: Hong
Kong and Macao) prohibit the use of GPS within their territories
and in the vicinity of their borders.
Violations will be prosecuted by local authorities.
Notes on function
• Prerequisite for GPS triangulation is “Line of Sight” (LoS) to at
least 3 GPS satellites (up to 9 of the total 24 GPS satellites are
available from any point on Earth at all times). The camera
should therefore always be held with the GPS antenna pointing
straight upwards.
• Make sure not to cover the GPS antenna with your hand or any
object (specifically metallic objects).
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REGULATORY INFORMATION
You will find the manufacturing date of your camera on the stickers
in the Warranty Card and/or on the packaging.
The date format is year/month/day.
Specific regional approvals for this device can be found in the
camera menu.
▸ Select Camera Information in the main menu
▸ Select Regulatory Information
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• Perfect signal reception from GPS satellites may be impossible in
the following locations or under the circumstances listed below.
Geolocation may then be impossible or erratic at best.
– in enclosed spaces
– underground
– under trees
– in a moving vehicle
– in the vicinity of tall buildings or in narrow valleys
– in the vicinity of high-voltage lines
– in tunnels
– in the vicinity of mobile phones
– with an accessory attached to the flash shoe, e.g. a flash unit
We recommend recommissioning the GPS function in a location
with good signal reception if the camera has not been used for an
extended period of time.
Notes on safe use
The electromagnetic radiation generated by the GPS system may
affect electronic instruments and measuring devices. Make sure to
disable the GPS function on board an aircraft before takeoff or
landing, in hospitals and other locations where RF restrictions
apply.
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CE MARK
The CE mark on our products documents compliance with the
fundamental requirements of applicable EU guidelines.
English
Declaration of Conformity (DoC)
Hereby, “Leica Camera AG” declares that this product is in compliance
with the essential requirements and other relevant provisions of Directive
2014/53/EU.
Customers can download a copy of the original DoC to our Radio Equipment
products from our DoC server:
www.cert.leica-camera.com
In case of further questions, please contact: Leica Camera AG, Am LeitzPark 5, 35578 Wetzlar, Germany
Depending on product (see technical data)
Type

Frequency band (central

Maximum power

WLAN

frequency)
2412–2462/5180–5240 MHz/

(dBm E.I.R.P.)
20

Bluetooth® Wireless

5260–5320/5500–5700 MHz
2402–2480 MHz

20

Technology
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DISPOSAL OF ELECTRICAL AND ELECTRONIC
EQUIPMENT
(Applies within the EU and for other European countries
with active waste separation policies.)
This device contains electric and/or electronic components which
must not be disposed of in general household waste. Instead, it
should be disposed of at a recycling collection point provided by
your local authority.
This service is free of charge. Any standard or rechargeable
batteries used in this device must be removed and disposed of
separately in accordance with local regulations.
Please contact your local authorities, waste disposal collection
point or the retailer, from whom you purchased the device for more
information on correct waste disposal.

Legal information

Legal information
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Legal information

• Appropriate measures must be taken to ensure security and
protect against disruptions to the systems in place where
devices or computer systems are in use that require more
stringent security than WLAN devices.
• Leica Camera AG shall not accept liability for damages arising
from the use of the camera for purposes other than as a WLAN
device.
• It is assumed that the WLAN function will be used in countries
where this camera is sold. There may be a risk of breaching
statutory wireless communication regulations when using the
camera in other countries. Leica Camera AG shall not accept
liability for such breaches.
• Please note that there is a risk of unauthorized third party
interception of wirelessly communicated data. We highly
recommend that you activate encryption in the wireless access
point settings to ensure data safety.
• Avoid using the camera in areas where it can be exposed to
magnetic fields, static electricity or other interferences, e.g. near
a microwave oven. RF transmissions may otherwise not reach
the camera.
• Using the camera near devices like microwave ovens or wireless
phones that use the 2.4 GHz RF band may negatively affect the
performance of both devices.
• Do not attempt to connect to wireless networks you are not
authorized to use.
• The device will automatically search for wireless networks, once
the WLAN function is enabled. A list, including networks you are
not authorized to access, will be displayed (SSID: Network
identifier for a WLAN network). Do not attempt to connect to

such a network, as this could be construed as unauthorized
access.
• We recommend disabling the WLAN function while on an
aircraft.
• Please read the important notes on specific functions of Leica
FOTOS on p. 112.
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IMPORTANT NOTES REGARDING THE USE OF
WLAN/BLUETOOTH®
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SAFETY REMARKS

Safety remarks

GENERAL INFORMATION
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• Do not use your camera in the immediate vicinity of devices that
generate powerful magnetic, electrostatic or electromagnetic
fields (e.g. induction ovens, microwave ovens, television sets or
computer screens, video game consoles, cell phones, broadcasting equipment). Their electromagnetic fields can interfere
with recordings.
• Strong magnetic fields, e.g. from speakers or large electric
motors can damage the stored picture data or disrupt recording.
• Switch off the camera, remove the battery briefly, replace it and
switch the camera back on in case of a camera malfunction due
to the effects of electromagnetic fields.
• Do not use the camera in the immediate vicinity of radio
transmitters or high-voltage power lines. Their electromagnetic
fields may interfere with recordings.
• Always store small parts e.g. the accessory shoe cover as
follows:
– out of the reach of children
– in a safe location, where they will not get lost or stolen
• State-of-the-art electronic components are sensitive to static
discharge. Since people can easily pick up charges of several
10,000 volts by walking on synthetic carpets, a discharge can
occur when you touch the camera, and especially it is placed on
a conductive surface. A static discharge on the camera housing
poses no risk for the electronics. Despite built-in safety circuits,
you should avoid direct contact with external camera contacts
like those in the flash shoe.

• Take care not to soil or scratch the sensor for lens detection in
the bayonet. You must similarly prevent direct contact of the
bayonet with grains of sand or similar particles, as these could
cause irreparable damage. This component must only be
cleaned with a dry cloth (in system cameras).
• Use a cotton or linen cloth instead of a microfiber cloth from an
optician's (synthetic) when cleaning the contacts. Make sure to
discharge any electrostatic charge by deliberately touching a
heating or water pipe (conductive, grounded material). Dirt
deposits and oxidation on the contacts can be avoided by
storing your camera in a dry location with the lens cap and the
flash shoe/viewfinder cap (in system cameras) attached.
• Only use accessories specified for this model to prevent faults,
short circuits or electric shock.
• Do not attempt to remove parts of the housing (covers) yourself.
Repairs must be done at authorized service centers only.
• Protect the camera against contact with insect sprays and other
aggressive chemicals. Petroleum spirit, thinner and alcohol must
not be used for cleaning. Some chemicals and liquids can
damage the camera housing or the surface finish.
• Rubber and plastics are known to expel aggressive chemicals
and should therefore not be kept in contact with the camera for
extended periods of time.
• Prevent any sand or dust or water penetration into the camera,
e.g. during snowfall or rain or on the beach. Be extra careful
when changing the lens (in system cameras) and when inserting
or removing the memory card and rechargeable battery. Sand
and dust can damage the camera, the lens, the memory card
and the battery. Moisture can cause malfunctions and
irreparable damage to the camera and memory card.

Legal information
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• A camera lens can have the effect of a magnifying glass when
exposed to direct frontal sunlight. The camera must therefore be
protected against extended exposure to direct sunlight.
• Attaching the lens cap and keeping the camera in the shade or
ideally in its camera case, will help prevent damage to the
interior of the camera.

RECHARGEABLE BATTERY
• Improper use of the batteries or the use of unapproved battery
types may result in an explosion!
• Do not expose the rechargeable battery to sunlight, heat,
humidity or moisture for prolonged periods of time. Likewise, the
batteries must not be placed in a microwave oven or a
high-pressure container as this would pose a fire or explosion
hazard.
• Do not under any circumstances charge or insert a damp or wet
battery into the camera!
• A safety valve in the battery ensures that any excess pressure
caused by improper handling is discharged safely. It is nevertheless important to dispose of a bloated battery immediately. It
may pose an explosion hazard!
• Keep the battery contacts clean and easily accessible. Although
lithium-ion batteries are secured against short circuits, they
should still be protected against contact with metal objects like
paper clips or jewelry. A short-circuited battery can get very hot
and cause severe burns.
• When a battery is accidentally dropped, make sure to check the
housing and the contacts immediately for any damage. A
damaged battery can damage the camera.

• The battery must be removed from the camera or charger and
must be replaced immediately in case of a strange smell,
discoloration, deformation, overheating or leakage. Continued
use of the battery may result in overheating, which can cause
fire and/or explosion!
• Never throw batteries into a fire as they may explode.
• Keep the battery away from sources of heat in case of leakage
or if you smell burning. Leaked fluid can catch fire!
• The use of other chargers not approved by Leica Camera AG can
cause damage to the batteries – and in extreme cases – cause
serious or life-threatening injuries.
• Make sure that the power socket is freely accessible at all times.
• Do not attempt to open the battery or the charger. Repairs must
only be carried out by authorized service centers.
• Keep batteries out of the reach of children. Batteries can cause
suffocation when swallowed.
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Safety remarks

LENS

FIRST AID
• Battery fluid may cause blindness if it comes into contact
with the eyes. Rinse the eyes thoroughly with clean water
immediately. Avoid rubbing. Seek medical attention
immediately.
• Leaked battery fluid poses an injury hazard when it comes in
contact with clothing or skin. Rinse the affected areas
thoroughly with clean water.

CHARGER
• Using the charger in the vicinity of broadcasting receivers may
interfere with reception. Ensure a distance of at least 1 m (3 ft)
between the charger and the receiver.
9

• When the charger is in use, it may emit a buzzing sound – this is
normal and not a malfunction.
• Disconnect the charger from the mains when it is not in use, as
it consumes electricity (a very small amount), even if no battery
is inserted.
• Always keep the charger contacts clean, and never short circuit
them.
• The in-car charging cable must only be operated in 12V in-car
grids and must never be connected while the charger is
connected to mains electricity.

MEMORY CARD
• Never remove the memory card during a datasave or card
reading process. The camera must not be switched off or be
subjected to impact or vibrations while working.
• Do not open the cover/remove the memory card or the battery
while the status LED is lit, which indicates memory access. Data
on the card may otherwise be destroyed and camera malfunctions may occur.
• Do not drop or bend memory cards as this will cause damage
and result in the loss of stored data.
• Do not touch the connections on the reverse of the memory card
and keep them clean and dry.
• Keep memory cards out of the reach of children. Swallowing a
memory card may cause suffocation.

SENSOR
• Cosmic radiation (e.g. during flights) may cause pixel defects.

10

CARRY STRAP
• Carry straps are usually made of very robust material. You should
therefore keep it out of the reach of children. A carry strap is not
a toy and poses a strangulation risk.
• Use the carry strap only for its intended purpose on a camera or
on binoculars. Any other use poses the risk of injury and may
possibly result in damage to the carry strap and is therefore not
permitted.
• Carry straps should also not be used for cameras/binoculars
during sports activities that pose a risk of entanglement (e.g.
when mountain climbing and similar outdoor activities).

TRIPOD
• When using a tripod, make sure it is standing securely and turn
the camera only by turning the tripod, not the actual camera.
Ensure that the tripod screw is hand-tightened only. Avoid
transporting the camera while the tripod is attached. You might
injure yourself or others and the camera could get damaged.

FLASH
• The use of incompatible flash units with your Leica M10
Monochrom can result in irreparable damage to the camera
and/or the flash unit.

Safety remarks

Safety remarks
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GENERAL INFORMATION

RECHARGEABLE BATTERY

Please read the section about “Care/Maintenance” for more
information about what to do in case of problems.

• The battery must have a temperature between + 0°C and
+ 30°C for charging (otherwise the charger will not switch on or
will switch off again immediately).
• Lithium-ion batteries can be charged at any time, regardless of
their current charge level. A partially charged battery will charge
to full capacity faster than a fully discharged one.
• The rechargeable batteries come only partly charged ex works
and should therefore be charged fully before their first use.
• A new battery only reaches its full capacity after it has been fully
charged and – by using it in the camera – depleted 2 to 3 times.
This depletion process should be repeated roughly every 25
cycles.
• Battery and charger heat up during the charging process. That is
normal and not a malfunction.
• Rapid flashing of the two LEDs (> 2 Hz) when charging
commences indicates a charging error (e.g. maximum charging
time exceeded, voltages or temperatures outside permitted
ranges or a short circuit). Disconnect the charger from the
mains and remove the battery. Ensure that the above temperature conditions are met and then restart the charging process.
Please contact your dealer, the Leica office in your country or
Leica Camera AG if the problem persists.
• Rechargeable lithium-ion batteries generate power by way of
internal chemical reactions. These reactions are influenced by
ambient temperature and humidity. To ensure a maximum
service life of the battery, it should not be exposed to extreme
temperatures (high or low) for extended periods of time (e.g. in a
parked car in the summer or winter).

CAMERA/LENS
(For system cameras)
• Make a note of the serial numbers of your camera (engraved in
the base of the camera housing) and lenses, as this information
will be extremely important in case of loss.
• Make sure to always have a lens or the camera bayonet cover
attached to prevent dust or other foreign bodies penetrating the
camera.
• That is why you should always replace lenses quickly and in a
dust-free environment.
• Never store the camera bayonet cover or the lens back cover in
a pants pocket, as they will attract lint and dust, which could
then be accidentally introduced into the camera.

LCD PANEL
• Condensation may form on the LCD panel if the camera is
exposed to great temperature fluctuations. Wipe the screen
carefully with a soft, dry cloth.
• The screen image will initially be slightly darker than normal if
the camera is very cold when it is switched on. The normal level
of brightness will be reached as soon as the LCD panel warms
up.
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• We recommend formatting memory cards from time to time,
because fragmented residual data from deleted files may block
some of the storage capacity.
• Generally, it is not necessary to format (initialize) memory cards
that have been previously used. Formatting will, however, be
necessary if you insert an unformatted memory card or a card
that was formatted in another device (e.g. a computer) for the
first time.
• We recommend backing up your data on a PC, because
electromagnetic fields, static electricity and any damage to the
memory card or camera defects may result in irretrievable
damage or loss of your data.
• SD, SDHC, and SDXC memory cards come with a write
protection slider to prevent accidental overwriting. This slider is
located on the non-beveled side of the card. All data on the card
is protected when the slider is set to its lower position, marked
LOCK.
• All data stored on a memory card will be lost during formatting.
Formatting will not be prevented by the deletion protection set
for individual pictures.

MEMORY CARD

• Any dust or dirt particles stuck to the glass cover of the sensor
may result in noticeable dark stains or specks on the pictures (in
system cameras). You can send your camera to the Leica
Customer Care department for sensor cleaning (see p. 138).
This service is not part of the warranty offering and will therefore
incur charges.

• The range of available SD/SDHC/SDXC cards on the market is
too extensive for Leica Camera AG to test for compatibility and
quality. Generally, any type of memory card may be used without
any damage to the camera or memory card. As some "no name"
cards may not fully comply with the SD/SDHC/SDXC standards,
Leica Camera AG cannot provide any guarantee of function.
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• However, every battery has a limited service life! After several
hundred charging cycles, this limitation will become evident as
the operating times get significantly shorter.
• The replaceable battery supplies power to a backup battery,
which is permanently installed in the camera. This backup
battery retains the date and time for some weeks. Once the
backup battery is depleted, it must be replenished by inserting a
charged main battery. The time and date will have to be set
again after a full depletion of both batteries.
• As the battery capacity deteriorates or if using an older battery,
warning messages may appear and some functions may be
restricted or blocked entirely.
• Remove the battery if the camera will not be used for an
extended period of time. Make sure to switch the camera off via
the main switch before removing the battery. Leaving the battery
in the camera will result in a deep discharge after a few weeks.
Voltage levels will decrease significantly, as the camera uses a
low idle current to maintain settings.
• Dispose of damaged batteries in accordance with the relevant
regulations at an approved collection point for proper recycling.
• The date of manufacture can be found on the battery. The date
format is week/year.

SENSOR
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DATA

FIRMWARE UPDATE

• All data, including personal information, may be changed or
deleted due to incorrect or accidental operation, static
discharge, accidents, malfunctions, repairs and other measures.
• Please note that Leica Camera AG does NOT accept liability for
direct or consequential damage due to the manipulation or
destruction of data and personal information.

Leica is continuously working on the further development and
optimization of the Leica M10 Monochrom. As digital cameras
have many functions that are controlled electronically, improvements and enhancements to the functions can be installed on the
camera retroactively. Leica releases what are known as firmware
updates at irregular intervals. Cameras are always supplied from
the factory with the latest firmware. Otherwise you can download it
from our website yourself and transfer it to your camera.
You will receive a newsletter informing you of the availability of a
new firmware update if you register your camera on the Leica
Camera homepage.
Visit the download section or the "Customer Area" for information
about how to register or how to get firmware updates for your
Leica M10 Monochrom. Additionally, you can find information
about changes or additions to the manual at: club.leica-camera.
com
Leica releases firmware updates for lenses at irregular intervals.
You can download any new firmware version from our homepage
and transfer it to your lens. Please see p. 111 for more information.
Select the menu item Camera Information (see p. 111) to check
whether your camera and lenses are running the latest firmware
version.

WARRANTY

Warranty

In addition to your statutory warranty rights regarding your dealer,
you will receive an additional Leica Camera AG product warranty
valid from the date of purchase at an authorized Leica retailer.
Previously, the product warranty was included with the product in
the packaging. From now on, the product warranty will only be
available online as a new service. You will be able to review the
warranty conditions for your product at any time, without having to
search fr the document. Please note that this new policy applies
only for products that are no longer delivered with a hardcopy
product warranty included in the packaging. Any products still
delivered with the warranty document in the packaging remain
governed exclusively by that document. For more information
regarding the warranty scope, services and limitations, please visit:
warranty.leica-camera.com
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* L eica M lenses with viewfinder attachment cover the brightness sensor.
Please read the sections “Displays (viewfinder)” and “Leica M lenses” for
more information about how to work with these and other lenses.
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Locking toggle for bottom cover
Bottom cover locking point
Tripod thread A ¼, DIN 4503 (¼”)
Battery release lever
Memory card slot
Battery compartment
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Part Designations

Main switch
Shutter button
3
Shutter speed setting dial
a Alignment point for shutter speed setting wheel
4
ISO setting wheel
a Index for ISO setting wheel
5
Strap lugs
6
Accessory shoe
7
Rangefinder window
8
Brightness sensor*
9
Self-timer LED
10
Viewfinder window
11
Focus button
12
Lens release button
13
Leica M bayonet
a 6-bit encoding
(sensor for lens detection)
14
Image field selector
15
Viewfinder eyepiece
16
Thumbwheel
17
Brightness sensor for LCD panel
18
LV button
19
PLAY button
20
MENU button
21
Status LED
22
LCD panel
23
Directional pad
24
Center button
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LENS*
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Part Designations
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34

32a

a

32
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34

34a

34b

33a

b
c
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Lens hood
Aperture setting ring with scale
Index for exposure values
Focus ring
Focus tab
Fixed ring
Alignment point for focus setting
Depth of field scale
Alignment button for lens replacement
6-bit encoding
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* Not included in the delivery package. Representative image. Technical
features may vary depending on model.
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Part Designations
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DISPLAYS

Displays

VIEWFINDER

3

Digital display
a.

:
– Displays the automatically calculated shutter speed in
aperture priority mode A or the countdown of longer
shutter speeds in 1 s increments.
– Warning that the metering or setting ranges are
overshot or undershot using aperture priority mode A
– Exposure compensation value (appears for a short
time during setting and for about 0.5 s when
activating exposure metering by tapping the shutter
button)
– Notification for (temporarily) full cache
– Message: No memory card (Sd)
– Message: Memory card full (Full)

b.

• (top):
– Indicates (when lit) that the metering memory lock is
active

c.

• (bottom):
– Indicates (flashing) that exposure compensation is in
use

d.

:
– for manual exposure setting:
Concurrently as light balance for exposure compensation. The triangular LEDs give the direction of
rotation of the aperture setting ring and shutter
speed setting wheel to adjust the exposure.
– Warning before the measuring range is undercut

e.

Flash symbol:
– Flash ready to use
– Details of flash exposure before and after exposure

1
2

3
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1

Bright-line frame (e.g. 50 mm + 75 mm)

2

Metering field for focusing

LCD PANEL

IN REVIEW MODE

EN

All displays/values refer to the actual settings

Displays

WHEN TAKING A PICTURE
All displays/values refer to the actual settings

1

In Live View mode
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When using the rangefinder
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1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
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23
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White balance mode
(not available in monochrome models)
File format/compression level/resolution
Exposure metering method
Picture mode (Drive Mode)
WLAN/Leica FOTOS
GPS
Flash sync point
Lens information
Battery capacity
Histogram
Clipping identification of underexposed (blue), or
overexposed subject sections (red)
Focus peaking
(identification of in sharp edges in the object)
Exposure metering field
(only available in Spot exposure metering method)
Grid lines (choice of 2 variants)
Exposure mode
ISO Sensitivity
Light balance
Exposure compensation scale
Shutter speed
Exposure preview
Remaining number of exposures incl. trend detection via
bar chart
Remaining memory card capacity
User profile
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File name
Icon for marked picture
Display of cropped section size and position
(only visible for enlarged sections)
File number of the picture shown

CHARGE STATUS INDICATOR ON THE LCD PANEL

Display

Displays

The battery charge status is displayed in the status pane and in the
header line.

EN

Charge status
approx. 88 - 100%
approx. 63 - 87%
approx. 47 - 62%
approx. 36 - 46%
approx. 26 - 35%
approx. 0 - 25%
The battery needs charging or replacing

27

EN

PREPARATION

PREPARING THE CHARGER

Preparation

ATTACHING THE CARRY STRAP

Use the mains cable with the matching regional plug to connect
the charger to mains electricity.

Attention
• Once you have attached the carry strap, please make sure that
the clips are mounted correctly to prevent the camera from
falling.

28

Note
• The charger will automatically adapt to local mains voltage.

CHARGING THE BATTERY

CHARGE STATUS INDICATORS ON THE CHARGER

Preparation

The camera is powered by a lithium-ion battery.

EN

INSERTING THE BATTERY IN THE CHARGER

The status LED indicates a correct charging process.
Display

Charge status

Charge time*

CHARGE flashes

battery is charging

80% lights up orange

80%

approx. 2 hours

CHARGE continuous
green light

100%

approx. 3½ h

green
▸ Slide the battery into the charger with the grooves facing down,
until the contacts meet
▸ Press down on the battery until you can hear and feel it clicking
into place
▸ Ensure that the battery is fully inserted into the charger

REMOVING THE BATTERY FROM THE CHARGER

Disconnect the charger from mains electricity when the charging
process is complete. There is no risk of overcharging.

▸ Tilt the battery up and lift it out at an angle
* for a completely discharged battery
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INSERTING/REMOVING THE BATTERY

INSERTION

▸ Ensure that the camera is switched OFF (see p. 42)
▸ Open the bottom cover and close it again afterwards (see p.
32)
Important
• Removing the battery while the camera is switched on may
result in the loss of custom settings or damage to the memory
card.
• Make sure that the bottom cover is securely closed before
switching on the camera.

REMOVAL

30

The camera will save exposures to an SD (Secure Digital), SDHC
(High Capacity) or SDXC (eXtended Capacity) memory card.
Notes
• SD/SDHC/SDXC memory cards are available from various
suppliers in various sizes and with differing read/write speeds.
Memory cards with high storage capacities and high read/write
speeds offer quick storage and rendering.
• The memory card may not be supported (capacity) or will have
to be formated before first use (see p. 109). The camera will in
that case display a relevant message. Please see the section
"Technical Data" for information about supported cards.
• Check the memory card for correct alignment if you are having
difficulties inserting it into the camera.
• See p. 10 and p. 13 for additional information.
• Removing the bottom cover or the memory card while the
camera is switched on, or switching on the camera while the
bottom cover is not attached will trigger the following warning
message on the display:
– Bottom cover removed.
– No card available.

The memory card slot is located directly next to the battery
compartment.

EN

▸ Ensure that the camera is switched OFF (see p. 42)
▸ Open the bottom cover and close it again afterwards (see p.
32)

Preparation

INSERTING/REMOVING THE MEMORY CARD

INSERTION

REMOVAL

31
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OPEN/CLOSE THE BOTTOM COVER

Preparation

OPEN

▸ Click up the locking toggle
▸ Turn the locking toggle in anti-clockwise direction
▸ Remove the bottom cover

32

CLOSE

▸
▸
▸
▸

Insert the bottom cover
Turn the locking toggle in clockwise direction
Click down the locking toggle
Check that the bottom cover was inserted and closed correctly

LENS

LEICA M LENSES
Most Leica M lenses can be used with any lens equipment (with or
without 6-bit encoding in the bayonet). Your camera will also
deliver great pictures with Leica M lenses without encoding. We
recommend entering the lens model type manually to ensure the
best possible image quality (see p. 38).
Please read the following sections for details on the very few
exceptions and limitations.
Notes
• Our Leica Customer Care department can retrofit many Leica M
lenses with 6-bit encoding.
• Leica M lenses come with a control curve that mechanically
transfers the set distance to the camera to allow manual
focusing via the rangefinder of the Leica M camera. Please note
the following when using the rangefinder with wide-aperture
lenses (≥ 1.4):
– The focusing mechanism of every camera and every lens is
adjusted individually at the Leica Camera AG factory in
Wetzlar with the greatest possible precision. Extremely narrow
tolerances are adhered to in this process, which allow precise
focusing of every camera/lens combination in photographic
practice.

EN

Preparation

COMPATIBLE LENSES

– If wide-aperture lenses (≥ 1.4) are used with an open
aperture, the then sometimes resulting very low depth of field
and inaccuracies in focusing with the rangefinder may lead to
setting errors resulting from the (added) overall tolerance of
the camera and lens. It can therefore not be ruled out that a
specific camera/lens combination may result in systematic
deviations.
– We recommend having the lens and camera checked by Leica
Customer Care if you notice a general deviation of the focal
position in a specific direction over time. Our technicians will
ensure that both products are calibrated within the permissible overall tolerance. However, a 100% match of the focal
position cannot be achieved for all pairings of cameras and
lenses.
LEICA R-LENSES (WITH ADAPTER)
The optional accessory R-adapter M allows the use of Leica-R
lenses as well as Leica M lenses. Please visit the Leica Camera AG
website for more information on this accessory.
us.leica-camera.com/Photography/Leica-M/Technical-Equipment
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LENSES WITH LIMITED COMPATIBILITY
COMPATIBLE, BUT MAY POSE RISK OF DAMAGE TO THE
CAMERA AND/OR LENS
– Lenses with retractable tube must only be used with the tube
extended, i.e. never attempt to retract the tube while the lens is
attached to the camera. This does not apply for the current Makro-Elmar-M 90 f/4 model, as its tube will not retract into the
camera itself and can therefore be used without restriction.
– When using Heavy lenses attached to a tripod-mounted camera,
e.g. Noctilux 50 f/0.95 or Leica R lenses with an adapter: make
sure that the tilt of the tripod head cannot move inadvertently
when the camera is not held. A sudden tilt and impact could
result in damage to the lower edge of the camera bayonet. That
is why you should always use the tripod mount on relevantly
equipped lenses.

COMPATIBLE, BUT EXACT FOCUSING MAY BE LIMITED
Despite the high precision of the rangefinder on the camera, exact
focusing with 135 mm lenses with an open aperture cannot be
guaranteed due to the very low depth of field. We therefore
recommend stopping down by at least 2 steps. Live View mode, on
the other hand, plus the various setting aids provided, allow
unrestricted use of this lens.
USABLE, BUT EXPOSURE METERING IS POSSIBLE ONLY IN
LIVE VIEW MODE
– Super-Angulon-M 21 f/4
– Super-Angulon-M 21 f/3.4
– Elmarit-M 28 f/2.8 (Serial numbers below 2 314 921)

INCOMPATIBLE LENSES
–
–
–
–

Hologon 15 f/8
Summicron 50 f/2 with close-up function
Elmar 90 f/4 with retractable tube (manufactured 1954-1968)
Some examples of the Summilux-M 35 f/1.4 (non-aspherical,
manufactured 1961-1995, Made in Canada) cannot be attached
to the camera or cannot focus to infinity. Leica Customer Care
can modify these lenses for use with the camera.

CHANGING THE LENS

REMOVAL

Preparation

LEICA M LENSES
ATTACHING

▸ Ensure that the camera is switched OFF (see p. 42)
▸ Hold the lens on the fixed ring
▸ Position the alignment button on the lens opposite the release
button on the camera housing
▸ Attach the lens in this position
▸ Turn the lens clockwise until you hear and feel it click into place

EN

▸
▸
▸
▸

Ensure that the camera is switched OFF (see p. 42)
Hold the lens on the fixed ring
Press and hold the release button on the camera housing
Turn the lens counter-clockwise until the alignment button is
opposite the release button
▸ Remove the lens
Important
• Make sure to always have a lens or the camera bayonet cover
attached to prevent dust or other foreign bodies penetrating the
camera.
• That is why you should always replace lenses quickly and in a
dust-free environment.
35
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OTHER LENSES
(e.g. Leica R lenses)

Preparation

Other lenses can be used by inserting an adapter for M bayonets
(e.g. Leica R-Adapter M).

DETACHING THE ADAPTER

2

ATTACHING THE ADAPTER

3
1

2
1

▸ Ensure that the camera is switched OFF
▸ Position the alignment point on the adapter opposite the
alignment point on the camera housing
▸ Attach the lens in this position
▸ Turn the adapter clockwise until you hear and feel it click into
place
▸ Attach the lens immediately
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▸
▸
▸
▸

Ensure that the camera is switched OFF
Detaching the lens
Press and hold the release button on the camera housing
Turn the adapter counter-clockwise until the alignment point is
opposite the release button
▸ Remove the adapter

ATTACHING THE LENS TO THE ADAPTER

DETACHING THE LENS FROM THE ADAPTER

2

Preparation

2
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1

3

1

▸ Ensure that the camera is switched OFF
▸ Hold the lens on the fixed ring
▸ Position the alignment point on the lens opposite the alignment
point on the adapter
▸ Attach the lens in this position
▸ Turn the lens clockwise until you hear and feel it click into place

▸
▸
▸
▸

Ensure that the camera is switched OFF
Hold the lens on the fixed ring
Press and hold the release button on the adapter
Turn the lens counter-clockwise until its alignment point is
opposite the release button
▸ Remove the lens
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LENS DETECTION

USING A LEICA M LENS WITH 6-BIT ENCODING

The 6-bit encoding in the bayonet of current model Leica M lenses
allows the camera to detect the lens type.
– This information is used for e.g. picture data optimization. Edge
darkening, for example, which can become noticeable when
wide-angle lenses and large apertures are used, is compensated
in the relevant picture data.
– The information provided by the 6-bit encoding is also written to
the EXIF data of the pictures. The focal length of the lens is
additionally displayed when rendering the extended picture data.
– The camera will write an approximate exposure value to the EXIF
picture data, which is calculated individually using the exposure
metering system. This is done whether or not an encoded or
unencoded lens or a non-M lens is attached via adapter, and
regardless of whether the lens type was entered in the menu.

The camera will automatically set the correct lens type when a
Leica M lens with 6-bit encoding is used. No manual setting will be
required. The camera will switch to Auto automatically when an
encoded Leica M lens is attached, regardless of the original lens
setting.
USING A LEICA M LENS WITHOUT 6-BIT ENCODING
The lens type must be entered manually when using a Leica M lens
without 6-bit encoding.
▸ Select Lens Detection in the main menu
▸ Select Manual M
▸ Select the attached lens from the list
• The lenses are listed with their focal length, apertures and
item number.

USING A LEICA R LENS
The lens type must also be entered manually when attaching a
Leica R lens via the Leica R adapter. The camera will automatically
switch to Manual R when a Leica R lens is attached, no matter what
setting existed originally. You will have to select the lens type from
the list.
▸ Select Lens Detection in the main menu
▸ Select Manual R
▸ Select the attached lens from the list

EN

Preparation

Notes
• Many lenses have their item number engraved on the opposite
side of the depth of field scale.
• The list also includes lenses that used to be available without
encoding (pre-June 2006). Newer lenses are all provided with
encoding and can therefore be automatically detected.
• When using the Leica Tri-Elmar-M 16-18-21 f/4 ASPH., the set
focal length is not transferred to the camera housing will
therefore also not be included in the EXIF picture dataset. You
can, however, enter the focal length manually.
• Tri-Elmar-M 28-35-50 f/4 ASPH., on the other hand, comes
equipped with the means for mechanical transmission of the set
focal length to the camera need for mirroring the correct
bright-line frame in the viewfinder. The focal length is scanned
by the camera electronics and the information is used for focal
length-specific corrections. Due to space limitations, the menu
only contains an item number (11 625). The two other variants
– 11 890 and 11 894 – can be used as well and the menu
settings will apply.
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DIOPTER COMPENSATION

Preparation

A diopter compensation function for up to ± 3 diopter is available
to allow glasses wearers the use of this product without eye
glasses.
The rangefinder can be fitted with an optional Leica correction lens
for that purpose.
us.leica-camera.com/Photography/Leica-M/Technical-Equipment/Viewfinder-Accessories/Correction-lenses
▸ Attach the correction lens flat against the viewfinder eyepiece
▸ Hand-tighten in clockwise direction
Notes
• Please note the information provided on the Leica homepage for
the selection on an appropriate correction lens.
• Please note that the viewfinder of the Leica M10 Monochrom is
set to -0.5 diopter as standard. If you wear eye glasses with
1 diopter, you will therefore need a correction lens with
+1.5 diopter.
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Preparation
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CAMERA OPERATION

Camera operation

CONTROL ELEMENTS

SWITCHING THE CAMERA OFF

Off

MAIN SWITCH
The main switch switches the camera on and off.
SWITCHING THE CAMERA ON

On
Note
• The function Auto Power Saving (see p. 57) deactivates the
camera automatically if no operation occurs within a preset
time. Use the main switch to deactivate the camera if this
function is Off to prevent inadvertent exposures and battery
discharge when the camera is not in use.

Notes
• Once switched on, the camera will be ready to use after approx.
1 s.
• The LED lights up briefly and the displays in the viewfinder
appear.
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SHUTTER BUTTON

Press down fully
– Shutter release
• The data is then transferred to the memory card.
– Starting a preselected self-timer delay
– Starting a picture series or interval shooting

Notes
• Press down the shutter button in a smooth motion until you hear
the click of the shutter to prevent camera shake.
• The shutter button remains locked:
– if the memory card inserted and/or the internal buffer
memory are (temporarily) full
– if the battery has exceeded its performance limits (capacity,
temperature, age)
– if the memory card is write-protected or damaged
– if the sensor is too hot

EN

Camera operation

The shutter button works in two stages.
1. Tapping (= Pressing the shutter button to the 1st pressure
point)
– Activating the camera electronics and displays
– Metering memory lock (metering & saving):
– saves the metered exposure value in aperture priority
mode, i.e. the shutter speed calculated by the camera
– Restarting a running self-timer delay time
– Return to picture mode
– from review mode
– from menu control
– from standby mode

2.
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SHUTTER SPEED SETTING DIAL

ISO SETTING WHEEL

The shutter speed setting dial has no stop, which means it can be
turned in either direction from any position. It will click at each
engraved position and for intermediate values. Intermediate
positions outside the click positions must not be used. Please read
the section “Exposure” (see p. 72) for details about exposure
settings.

– A: Automatic ISO sensitivity control
– 160 - 12.5K: Fixed ISO values
– M: Manual ISO sensitivity control
Fig. 1

Fig. 2

– A: Aperture priority
(automatic shutter speed control)
– 4000 – 8 s: Fixed shutter speeds of 1/4000 s to 8 s
(with intermediate values, clicking in ½ increments)
– B: Long-term exposure (bulb)
– : The shortest possible sync speed (1⁄180 s) for flash mode
▸ Push the ISO setting wheel up until you feel it clicking into place
and the red line (fig. 2) is visible
▸ Turn the setting wheel to the desired value
▸ Push down the ISO setting wheel
44

THUMBWHEEL

DIRECTIONAL PAD/CENTER BUTTON

EN

Camera operation

–
–
–
–
–

Menu navigation
Exposure compensation value selection
Enlarging/reducing viewed pictures
Setting selected menu items/functions
Scrolling through the picture memory

FOCUS BUTTON

DIRECTIONAL PAD
– Menu navigation
– Setting selected menu items/functions
– Scrolling through the picture memory
CENTER BUTTON
–
–
–
–

Accessing the status display
Applying menu settings
Display of settings/data when recording
Display of picture data during review

– Focus aid activation
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LV BUTTON/PLAY BUTTON/MENU BUTTON

LCD PANEL

LV BUTTON

– Display of most important current settings
– Quick access to some menus
– Touch control

Camera operation

EN

– Activating/deactivating the Live View mode
PLAY BUTTON
– Activation and deactivation of the (continuous) review mode
– Return to full-screen display
MENU BUTTON
– Accessing the FAVORITES or MAIN MENU
– Accessing the Review menu
– Exiting the currently displayed (sub) menu
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TOUCH CONTROL*

in Review mode

tap briefly

Shifting the metering field

Select the recording
Hide/show info displays

double tap

Focus aid activation

Enlarging/reducing viewed pictures

swipe

Shifts the enlarged image section

Scrolling through the picture memory
Shifts the enlarged image section

EN

Camera operation

in Picture mode (LV mode)

horizontal swipe
(full length)
vertical swipe
(full length)
touch and hold

two-finger pinch/
spread

Enlarging/reducing viewed pictures

swipe and hold/
hold and swipe
* A light touch is enough, don't apply pressure.

47

Camera operation

EN

MENU CONTROL

MENU SECTIONS

Menu sections: MAIN MENU and FAVORITES
MAIN MENU:
– contains all menu items

FAVORITES MENU

FAVORITES:
– your custom list (see p. 124 for details on how to manage this
list)

CONTROL ELEMENTS
The following elements are used for menu control.
16

18

24 23

19
20
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18 LV button

16 Thumbwheel

19 PLAY button

23 Directional pad

20 MENU button

24 Center button

The favorites menu offers quick access to the most frequently used
menu items. It can contain up to 15 menu items. These can be
assigned individually (see p. 54).

MAIN MENU

SUBMENU

The main menu offers access to all settings. Most of these are
organized in submenus.

There are various types of submenus available. The following pages
describe their operation.

B

F
G

C

F

G

I

H

D

E

A Menu sections: MAIN MENU/FAVORITES
B Menu item name
C Menu item setting
D Submenu reference
E Scrollbar: current position in the menu list

Note
• Some menu items can only be accessed under specific
circumstances. The text in the relevant line is displayed in gray
to signify the existence of a submenu.

F
G
H
I

Camera operation

A

EN

Current menu item
Submenu item
References to other submenus
Scrollbar

Note
• In some cases, an additional scale will be available, where values
can be set or function options can be selected.
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MENU NAVIGATION
DISPLAY “HOME” SCREEN
(INITIAL MENU CONTROL SCREEN)
if there are no menu items assigned to the favorites menu:
▸ Press the MENU button 1x
• MAIN MENU appears.
if at least one menu item was assigned to the favorites menu:
▸ Press the MENU button 1x
• FAVORITES menu appears.
Switching from FAVORITES to MAIN MENU

– if the favorites menu consists of one page:
▸ Press the MENU button 1x
– if the favorites menu consists of 2 pages:
▸ Press the MENU button 2x
or
▸ Select Main Menu (last item in the favorites menu)

SCREEN BY SCREEN NAVIGATION
Scrolling forward

▸ Press the MENU button
• Screen 1 of the main menu will be displayed again after
Screen 4.
LINE BY LINE NAVIGATION
(Function/function option selection)
▸ Press the directional pad up/down
or
▸ Turn the thumbwheel
(to the right = down, to the left = up)
• Once the last menu item has been reached scrolling up or
down, the display will automatically jump to the previous or
next screen. The currently active menu section (FAVORITES,
MAIN MENU) is not exited.
SHOW SUBMENU
▸ Press the center button
or
▸ Press the directional pad to the right

Switching from MAIN MENU to FAVORITES

▸ Press the directional pad left
Note
• MAIN MENU and FAVORITES are accessible only in recording mode.
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CONFIRM SELECTION

Note
• No confirmation is needed for the selection of On or Off. An
automatic save is done.
GO BACK ONE STEP

SUBMENU

EN

KEYBOARD/NUMBER PAD
A
B
E

C

F
D

(Return to the superordinate menu item)

▸ Press the directional pad left
• This option is only available for list-type submenus.
or

A
B

▸ Press the MENU button 1x
EXITING THE MENU

C

You can exit the menus and submenus at any time – with/without
applying the settings selected there.
go to picture mode

▸ Tap the shutter button
go to review mode

▸ Press the PLAY button

Camera operation

▸ Press the center button
• The screen image changes back to the active menu item. The
set function variant is shown on the right in the relevant menu
line.

D

A Entry line
B Keyboard/Number pad
C "Delete" button (deletes the last character entered)
D “Confirm” button

(to apply individual values and existing settings)

E Shift key (toggles between upper and lower case letters)
F Changing the character type
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Camera operation
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SELECTING A BUTTON (ICON/FUNCTION BUTTON)

Using button control
▸ Press the directional pad left or right as needed
• The currently active button will be highlighted.
or
▸ Turn the thumbwheel
• The currently active button will be highlighted.
• There will be an automatic jump to the next/previous line
when the end/beginning of the line is reached.
▸ Press the center button
Using touch control
▸ Press the button of your choice
SAVE
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SCALE MENU

Using button control
▸ Press the directional pad left/right
or
▸ Turn the thumbwheel

▸ Select button D

Using touch control

CANCEL

▸ Select the desired setting directly or swipe

▸ Press the MENU button

Notes
• The currently active setting displayed in the center is highlighted
in red.

COMBI MENU

To move to the next settings field

The setting of the individual menu items is done via a setting bar in
the lower display area.

▸ Press the directional pad left/right
or

To access individual menu items

EN

Camera operation

DATE/TIME MENU

▸ Press the center button
To set values

▸ Press the directional pad up/down
or
▸ Turn the thumbwheel
To save and return to superordinate menu item

▸ Press the center button on the last setting field

▸ Press the directional pad up/down
To set individual items

▸ Press the directional pad left/right
or
▸ Turn the thumbwheel
To apply the setting

▸ Press the center button
To return to the superordinate menu item

▸ Press the MENU button
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QUICK ACCESS

MANAGING THE FAVORITES MENU

Camera operation

FAVORITES MENU

▸ Select Customize Control in the main menu
▸ Select Edit Favorites
▸ Select the desired menu item

Assign your most frequently used menu items to a favorites menu
(up to 15 items) for quick and easy access. The available functions
are shown in the list on p. 124.

▸ Select On/Off
• A warning message appears when the favorites menu has
reached the maximum of 15 menu items and no further items
can be added.
Note
• The favorites menu will be deleted completely if all menu items
are set to Off.
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VIA THE STATUS SCREEN

DIRECT ACCESS

▸ Select Customize Control in the main menu
▸ Select Customize Wheel
▸ Select Exp. Compensation/LV Zoom or Off
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Camera operation

Assign a menu function to the thumbwheel for extra quick
operation: Exp. Compensation or LV Zoom. The setting has no impact on
the function if focus assist tools are in use.

In addition to providing an overview of the most important settings,
the status screen also allows quick access to specific menu
functions.
Accessing the status screen

▸ Press the center button
Accessing a menu function

▸ Touch the field with the desired function
Returning to the status screen

▸ Press the MENU button
Returning to recording mode

▸ Tap the shutter button
Note
• The status screen is not available in LV mode.
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CAMERA BASIC SETTINGS

TIME

For details on how to navigate in the menus and for inputs see
chapter "Menu control" (p. 48).
• The two menu items Language and Date & Time appear automatically when switching the camera on for the first time, after a
factory reset (see p. 110) or after a firmware update.

▸ Select Date & Time in the main menu
▸ Select Time Setting
▸ Select the desired brightness
(12 Hours, 24 Hours)
▸ Set the time
(Select am or pm for the 12-hour format)

MENU LANGUAGE

AUTOMATIC TIME VIA GPS

Factory setting: English
Available menu languages: German, French, Italian, Spanish,
Portuguese, Russian, Japanese, Korean and Traditional or Simplified
Chinese

▸
▸
▸
▸
▸

▸ Select Language in the main menu
▸ Select your language
• Aside from a few exceptions, the language will be changed for
all information.

TIME ZONE

DATE/TIME

▸ Select Date & Time in the main menu
▸ Select Time Zone
▸ Select your time zone/current location

DATE

DAYLIGHT SAVING TIME

You can choose one of 3 options.

▸ Select Date & Time in the main menu
▸ Select Daylight Saving Time
▸ Select On/Off

▸ Select Date & Time in the main menu
▸ Select Date Setting
▸ Select the desired date format
(Day/Month/Year, Month/Day/Year, Year/Month/Day)
▸ Set the date
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Select GPS in the main menu
Select On
Select Date & Time in the main menu
Select Auto GPS Time
Select On

Notes
• Auto GPS Time is available only with an attached Leica Visoflex
(optional accessory) withactivated GPS function. The menu item
will otherwise be grayed out and unavailable for settings.
• Time Zone and Daylight Saving Time are available only if the GPS
function is set to OFF.

POWER SAVE MODE (STANDBY MODE)

LCD PANEL/VIEWFINDER (EVF) SETTINGS

EN

The camera will switch to the power-saving standby mode after a
preset time to extend battery life if this function is activated.
Factory setting: 2 minutes

The camera comes equipped with a 3” liquid crystal color panel,
which is protected by a glass cover made of extremely hard and
scratch-resistant Gorilla® glass.
In picture mode and with active Live View function, the screen
displays the image captured by the sensor via the attached lens. In
review mode, the images saved on the memory card are displayed
on the screen. In both cases, the screen shows the entire image
field, as well as the selected data and information. When using the
rangefinder, you can press the directional pad to call up the status
screen, which displays a selection of settings (see p. 46).

Camera basic settings

▸ Select Auto Power Saving in the main menu
▸ Select the desired setting
(2 minutes, 5 minutes, 10 minutes, Off)
Note
• The camera can be woken from standby mode at any time by
pressing the shutter button or by switching the main switch off
and on again.

The following functions can be configured and used individually:
– Brightness
– Information display
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BRIGHTNESS

INFORMATION DISPLAYS

RANGEFINDER

In Live View mode, the LCD panel can be used for displaying a
range of settings. Various information is displayed in the header
and/or footer line.

The brightness sensor automatically adjusts rangefinder brightness.
Note
This automatic control is not available for Leica M lenses with
viewfinder attachments, as they cover the brightness sensor that
supplies the required information. The frames and displays will
therefore be displayed at a constant brightness when Leica M
lenses are used.

F2.8

F2.8

1/8000 ISO 12500 EV

1/8000 ISO 12500 EV
999-9000

999-9000

INFO

INFO

LCD PANEL
You can adjust brightness for best visibility in various lighting
conditions.
▸ Select Display Brightness in the main menu
▸ Select the desired brightness of Auto

22:45PM 22.02.2012

12MP

22:45PM 22.02.2012
8234/9999

12MP

8234/9999

▸ Press the center button
• The display toggles between a visualization with or without
information displays.
Showing/hiding information temporarily

Depending on the initial situation, the display toggles to the other
setting when the shutter button is held at the first pressure point.
▸ Tap and hold the shutter button
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Initial situation

Temporary display

Visualization with displays
(Header and footer line)

Header and footer line are
hidden

Visualization without displays

The footer line is displayed
(Exposure information)

EN

Camera basic settings

You can select a number of other displays in addition to the
standard information contained in the header and footer to adapt
the image in picture and review mode to your needs. These include
assist functions for exposure settings, picture composition and
focusing (see p. 83).
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BASIC PICTURE SETTINGS

Basic picture settings

FILE FORMAT
Choose the JPG format JPG or the standardized raw data format DNG
(= digital negative). These can be used individually or simultaneously.
Factory setting: DNG
▸ Select File Format in the main menu
▸ Select a value
(DNG, DNG + JPG, JPG)
Notes
• The standardized DNG (Digital Negative) format is generally used
for the storage of raw data.
• When picture data is saved in DNG and in JPG format simultaneously, then the camera will use the resolution setting for the JPG
format is used for the JPG file.
• The DNG format always works with the highest available
resolution, no matter what JPG setting is selected.
• The remaining number of pictures shown in the LCD panel will
not necessarily change after every picture taken. A counter
change depends on the subject; very fine image structures
result in higher data quantities, while homogeneous surfaces
mean less data.
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JPG SETTINGS
The functions and settings described in this section apply for
pictures taken in JPG format only.

RESOLUTION
The JPG format setting offers 3 image resolution (number of pixels)
options. The following file formats are available: L-JPG, M-JPG and
S-JPG. You can therefore adjust your settings to the intended use
and available memory card capacity.
Factory setting: L-JPG
▸ Select JPG Settings in the main menu
▸ Select JPG Resolution
▸ Select the desired resolution
(L-JPG (40 MP), M-JPG (20 MP), S-JPG (6 MP))

TONING

One of the many advantages of digital photography is that it is very
easy to change key image properties.
You can manipulate contrast, sharpness and toning before
recording.

A color tone can be added to recordings. The color and intensity of
this effect can be adjusted.
Factory setting: Off

CONTRAST
The contrast setting, i.e. the difference between light and dark
image sections, determines whether an image comes across as
"flat" or "brilliant". Increasing or decreasing this difference impacts
on contrast, meaning that some image sections are rendered with
more or less light.
Factory setting: Standard

▸
▸
▸
▸

Select JPG Settings in the main menu
Select Toning
Select Hue
Select the desired tone
(Sepia, Blue, Selenium)
▸ Select Strength
▸ Select the desired intensity or deactivate the effect
(Off, Weak, Strong)

EN

Basic picture settings

IMAGE PROPERTIES

▸ Select JPG Settings in the main menu
▸ Select Contrast
▸ Select the desired level
(Low, Standard, High)
SHARPNESS
The impression of sharpness in a picture is largely determined by
edge sharpness, i.e. by how slight the transition area between light
and dark is at edges in the picture. Expanding or reducing these
areas will therefore change the impression of sharpness.
Factory setting: Standard
▸ Select JPG Settings in the main menu
▸ Select Sharpness
▸ Select the desired level
(Low, Standard, High)
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PICTURE MODE

Mode

Setting options/Variants

Picture mode

DRIVE MODE

Single frame
exposure

Single

Serial exposures
(see p. 79)

Speed:
– Continuous Low Speed
– Continuous High Speed

Self-timer
(see p. 82)

Delay time:
– Self Timer 2 s
– Self Timer 12 s

The functions and settings described in the following generally
refer to the exposure of individual pictures. In addition to single
frame shots, the Leica M10 Monochrom offers a number of other
picture modes. Please read the relevant sections for information
about functionalities and setting options.
▸ Select Drive Mode in the main menu
▸ Select the desired function options

Interval shooting
(see p. 80)
Exposure
bracketing
(see p. 81)
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Frames

Interval between the pictures (Interval Time)
Frames

(3 or 5)

F-Stops
Exp. Compensation

IMAGE TYPES

F2.8

EN

1/8000 ISO 12500 EV

B

999-9000

Picture mode

USING THE RANGEFINDER
IMAGE FIELD (BRIGHT-LINE FRAME)
The bright-line rangefinder of this camera is not just a very
high-quality, large, brilliant and bright viewfinder – it also doubles
as a highly precise, lens-coupled rangefinder. All Leica M lenses
with focal lengths between 16 and 135 mm are coupled automatically when they are attached to a camera. The viewfinder has a
magnification factor of 0.73x.
The bright-line frame is coupled with the focusing function in such
a way that the parallax – the offset between the lens axis and the
viewfinder axis – is compensated automatically. At ranges under 2
m, the sensor captures slightly less than indicated by the inner
edges of the bright-line frame, and slightly more at longer ranges
(see adjacent diagram). These slight, almost negligible deviations
are systemic. The bright-line frame of a camera with viewfinder
must be adapted to the view angle of the relevant focal length of
the lens. The nominal view angle changes slightly when focusing
due to the changing draw-out, i.e. the distance of the lens system
to the sensor level. When the set distance is below infinity (and the
draw-out accordingly greater), the actual view angle also decreases
– the lens captures less of the image object. The view angle
differences at greater focal lengths tend to be larger due to the
greater draw-out.

A
INFO

22:45PM 22.02.2012

12MP

8234/9999

All pictures and bright-line frame positions at 50 mm focal length

A
B

Set to 0.7 m
Set to 2 m
Set to infinity

Bright-line frame
Actual image field
The sensor captures around one frame width less
The sensor captures the exact image field shown
within the inner edges of the bright-line frame
The sensor detects around 1 to 4 (vertical or
horizontal) frame width(s) more

Notes
• The bright-light frames illuminated by white light LEDs appear
alongside the exposure meter LEDs at the lower edge of the
viewfinder image, once the camera electronics are activated.
• The rectangular distance measuring field, which is brighter than
the surrounding metering field, is in the center of the viewfinder
frame. Please read the relevant sections for more information
about distance and exposure metering.
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The relevant bright-line frame will light up in the combinations
35 mm + 135 mm, 50 mm + 75 mm or 28 mm + 90 mm when
lenses with a focal length of 28 (Elmarit as of serial number
2 411 001), 35, 50, 75, 90 and 135 mm are used.

28 mm + 90 mm
F2.8

1/8000 ISO 12500 EV
999-9000

35 mm + 135 mm
F2.8

1/8000 ISO 12500 EV
999-9000
INFO

22:45PM 22.02.2012

INFO

22:45PM 22.02.2012

12MP

8234/9999

50 mm + 75 mm
F2.8

1/8000 ISO 12500 EV
999-9000

INFO

22:45PM 22.02.2012
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12MP

8234/9999

12MP

8234/9999

SHOW ALTERNATIVE IMAGE RANGES/FOCAL LENGTHS

▸ Push the image field selector towards the lens
• The image field selector will snap back automatically when
released.

LIVE VIEW MODE
The Live View mode of this camera allows viewing the image object
on the display while the picture is taken. The image is show exactly
as it is rendered by the attached lens.
LIVE VIEW MODE ON/OFF

EN

Picture mode

Additional bright-line frames may be displayed depending on the
attached lens. These allow a simulation of the relevant focal
lengths. This process helps in the selection of the right lens for the
desired image range.

▸ Press the LV button
Notes
• Live View mode is based on the image captured by the sensor.
The camera must control the shutter. Shutter control is audible
and may result in a slight delay in shutter release.
• The camera will warm up when Live View mode is used for an
extended period of time. Power consumption will simultaneously
increase.
• Alternating current causes brightness fluctuations invisible to
the human eye in many light sources. This may result in a
flickering of the Live View screen image due to the sensitivity
and scan rate of the image sensors. Picture quality will not be
impacted. The effect can be avoided by selecting a slower
shutter speed.
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FOCUSING

SPLIT IMAGE METHOD

Various assist functions are provided for focusing, depending on
whether you use the camera's rangefinder or Live View mode.

For an architectural photograph, you might aim the metering field
of the rangefinder at e.g. the vertical edge or any other clearly
defined vertical line and keep turning the focus ring on the lens
until the edge contour or the line is visible at the outer edges of the
metering field without any offset.

VIA RANGEFINDER
The rangefinder of this camera is very precise due to its wide and
effective measurement base. Image sharpness can be via the
superimposed image or the split image method.
SUPERIMPOSED IMAGE METHOD (DOUBLE IMAGE)
For a portrait, you might focus on the eyes using the metering field
of the rangefinder, turning the focus ring on the lens until the
contours are aligned exactly inside the metering field.

out of focus

out of focus
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in focus

in focus

Notes
• Very precise distance measurements are particularly beneficial
when using wide-angle lenses with a relatively large depth of
field.
• The metering field of the rangefinder is displayed as a bright,
sharp-edged rectangle in both methods. The position of the
metering field cannot be changed. It will always be at the center
of the viewfinder.

IN LIVE VIEW MODE
(WITH ASSIST FUNCTIONS)

Your camera offers two useful assist functions to facilitate and
improve setting accuracy:
– The magnification of an (initially) central cropped section of the
screen image (Zooming).
– Marking of screen image sections where subject elements are in
clear focus (Focus Peaking)
The functions can be automatically activated during focusing or
can be accessed independently.

EN

Picture mode

You can set the image sharpness in Live View mode via the screen
image – it will show the image subject at the exact sharpness as it
is rendered by the lens based on the distance and aperture setting.

▸ Select Capture Assistants in the main menu
▸ Select Focus Peaking
▸ Select the desired setting
(Off, Red, Blue, Green, White)
▸ Select an image section
▸ Turn the focus ring to mark the desired subject elements
• All subject elements that are rendered in focus with the
selected distance setting are marked with a silhouette in the
selected color.
Notes
• Focus peaking is based on subject contrast, i.e. differences
between light and dark. As a result, high contrast subject parts
could be marked, even if they are not completely in focus.
• Display accuracy decreases when a wide-angle lens is used with
a small aperture (= high depth of field).

FOCUS PEAKING
This assist function highlights the edges of in focus subject
elements in color. The color can be user-specified.
F2.8

-3

2

1/8000 ISO 12500 EV

1

0

1

2

3+

12MP

8234
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ENLARGEMENT
1/8000 ISO 12500 EV

Picture mode

F2.8

ACCESSING ASSIST FUNCTIONS

-3

2

1

0

1

2

3+

12MP

8234

The larger the details of the subject are shown, the better you can
assess their sharpness and the more accurately you can focus.
Use the thumbwheel to choose one of two magnification factors.
Adjusting the enlargement function

▸ Turn the thumbwheel
Changing the position of the enlarged section

▸ Swiping will allow you to move the position of an enlarged
cropped section
or
▸ Press the directional pad left or right as needed
• The metering field is moved with the cropped section.

In the image at the bottom left, the position and zoom level of the
displayed cropped section is shown. The cropped section displayed
can also be unenlarged. The most recently used zoom level is used
each time assist functions are accessed.
When Focus Peaking is activated, will appear to the right of the
frame with a display of the color used. appears if Focus Peaking
is off.
The assist functions can be shown or hidden at any time independent of the focus setting.
Accessing the assist functions

▸ Press the focus button
or
▸ Double tap the LCD panel at the desired position
Deactivating the assist functions

Manually accessed assist functions remain active until they are
deactivated.
▸ Press the focus button
or
▸ Double tap the LCD panel
or
▸ Tap the shutter button
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VIA THE FOCUS RING

VIA THE THUMBWHEEL
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▸ Select Capture Assistants in the main menu
▸ Select Focus Assist
▸ Select Automatic

▸
▸
▸
▸

Picture mode

Assist functions can also be accessed automatically during
focusing.

Accessing the assist functions

▸ Turn the focus ring

The assist functions can additionally be accessed via the
thumbwheel.
Select Customize Control in the main menu
Select Customize Wheel
Select LV Zoom
Turn the thumbwheel to the right
• The assist functions are activated.

Preventing automatic activation

▸ Select Capture Assistants in the main menu
▸ Select Focus Assist
▸ Select Manual
Note
• The assist functions deactivate automatically about 5 s after the
last turn of the focus ring. That does not apply if the zoom level
was changed.
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ISO SENSITIVITY

Picture mode

The ISO setting covers a range between ISO 160 and ISO 100000,
allowing you to adapt to the relevant situation as required.
There is more leeway for the use of preferred shutter speed and
aperture combinations when setting the exposure manually. You
can set priorities within the scope of the automatic setting, e.g. for
reasons of picture composition.

FIXED ISO VALUES
VALUES ENGRAVED ON THE ISO SETTING WHEEL
▸ Turn the ISO setting wheel to the desired value
(160, 400, 800, 1600, 3200, 6400, 12.5K)
ALL AVAILABLE SETTINGS
Values between ISO 160 and ISO 100000 can be selected in 29
increments.
Factory setting: ISO 160
▸
▸
▸
▸

Choose a click value engraved on the ISO setting wheel or the
positions:
– A: for automatic setting; values between ISO 200 and 100000
will be used
– M: for intermediate values, as well as for higher or lower values
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Set the ISO setting wheel to M
Select ISO Setup in the main menu
Select M-ISO
Select the desired value

Note
• When high ISO values are used or the image is edited later,
image noise, as well as vertical and horizontal stripes may
become visible, particularly in larger, evenly lit areas of the
object.

The camera automatically adjusts the sensitivity to ambient
brightness and/or to the configured shutter speed/aperture
settings combination. In conjunction with aperture priority mode,
this function extends the range for automatic exposure control.
▸ Set the ISO setting wheel to A

LIMITING ISO VALUES

EN

▸ Select ISO Setup in the main menu
▸ Select Maximum Auto ISO
▸ Select the desired value

Picture mode

AUTOMATIC SETTING

All values from ISO 200 are available.
Factory setting: 3200

LIMITING SHUTTER SPEED RANGES

Factory setting: 1/f

or
▸
▸
▸
▸

Set the ISO setting wheel to M
Select ISO Setup in the main menu
Select M-ISO
Select ISO Auto

LIMITING SETTING RANGES
A max. ISO value can be set, which will then limit the automatic
setting range (Maximum Auto ISO). A max. exposure time can also
optionally be configured. There are focal length related settings
(1/f, 1/(2f), 1/(4f))1 and fixed max. shutter speeds from 1/2s to 1/500ss
available for that purpose.
In the focal length-specific settings, the camera will only switch to
a higher sensitivity if the shutter speed would fall below the set
threshold due to low light; for example with a 50 mm lens at
speeds slower than 1⁄60 s at 1/f, 1⁄125 s at 1/[2f] or 1⁄250 s at 1/[4f] .
Separate settings are available for flash photography.

This function requires the use of encoded lenses or the setting of the lens type
used in the menu.

▸ Select ISO Setup in the main menu
▸ Select Maximum Exposure Time
▸ Select the desired value
(1/f, 1/(2f), 1/(4f), 1/500 s, 1/250 s, 1/125 s, 1/60 s, 1/30 s, 1/15 s, 1/8 s,
1/4 s, 1/2 s)
LIMITING SHUTTER SPEED RANGES (FLASH)

Factory setting: 1/f

▸ Select Flash Settings in the main menu
▸ Select Max. Flash Sync. Time
▸ Select the desired value
(1/f, 1/(2f), 1/(4f), 1/125 s, 1/60 s, 1/30 s, 1/15 s, 1/8 s, 1/4 s, 1/2 s)

1
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EXPOSURE

WHEN USING THE RANGEFINDER

The readiness of the exposure meter is signaled by continuously lit
displays in the viewfinder or on the screen:
– the shutter speed is displayed in aperture priority mode
– one of the two triangular LEDs lights up in the viewfinder,
possibly in conjunction with the round LED in the middle, and
the light balance is shown on the LCD panel for a manual setting
The exposure meter is disabled when the shutter speed setting
wheel is set to B.

Mostly center-weighted metering.
The light reflected by the light-colored shutter blades is captured
and measured by a photodiode. When the measuring range of the
exposure meter is undercut in a manual setting and very low light
density, then the triangular LED ( ) in the viewfinder on the left will
flash as a warning; the LED on the right ( ) will flash when the
measuring range of the exposure meter is surpassed. The shutter
speed icon will flash as a warning if a correct exposure cannot be
achievable using the available shutter speeds in aperture priority
mode. The relevant icon will flash if the required shutter speed
would undercut the fastest possible shutter speed or overshoot the
longest possible shutter speed. As exposure metering is done with
the working aperture, the same can be achieved by stopping down
the lens.

EXPOSURE METERING METHODS
Optional methods are Spot metering, Center-Weighted and
Multi-Field metering.
SPOT METERING –
Spot metering only captures and analyzes a small area in the
middle of the screen image, which is shown in a circle.
CENTER-WEIGHTED
METERING

–

This method considers the entire image field. The subject elements
captured in the center will, however, impact on the calculation of
the exposure value more so than areas around the edges.
MULTI-FIELD METERING

–

This metering method is based on the detection of multiple values.
These values are used in an algorithm to calculate an exposure
value appropriate for a good rendering of the assumed main
subject.
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IN LIVE VIEW MODE
Optional methods are Spot metering, Center-Weighted and
Multi-Field metering. The metering will then be done via the picture
sensor.
▸ Select Exp. Metering in the main menu
▸ Select a metering method
(Spot, Center-Weighted, Multi-Field)
• The set metering method is displayed in the header of the
display image in Live Mode; it appears on the status screen
(see p. 46) if the viewfinder is used.

APERTURE PRIORITY - A

The camera offers two exposure modes: aperture priority mode or
manual setting. Choose one of the two options depending on
image subject, situation or individual preference.

Aperture priority mode sets the exposure automatically according
to the manually selected aperture. This mode is suitable for
pictures in which the depth of field is a critical compositional
element.
By selecting an appropriately low aperture value, you can reduce
the depth of field range, for example to make a face “stand out” in
sharp focus against an unimportant or distracting background.
Conversely, you can use a higher aperture value to increase the
depth of field range, so that everything from the foreground to the
background will be in full focus in a landscape shot.

Notes
• Image noise becomes apparent when using higher sensitivities,
particularly on uniform dark areas. In order to reduce this
annoying phenomenon, the camera will take a second “black
picture” (taken with the shutter closed) automatically after
pictures taken with slow shutter speeds and high ISO values. The
noise metered in this parallel picture is then digitally “subtracted” from the data for the actual picture. In such cases the
message Noise reduction will appear with a relevant time value.
The doubling of the “exposure” time must be taken into account
for long exposure times. The camera must not be switched off
during that time.
• The remaining exposure time after shutter release is counted
down in seconds on the display for shutter speeds greater than
2 s.
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Picture mode

EXPOSURE MODES

▸ Select the operating mode A (see p. 73)
▸ Set the desired aperture value
• The automatically selected shutter speed is displayed.
▸ Shutter release

SELECTING A MODE
▸ Set the shutter speed setting wheel A (Aperture priority) or
select the desired shutter speed (Manual setting = M)
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Notes
• The resulting shutter speed is displayed in half increments for
more transparency.
• The remaining exposure time after shutter release is counted
down in seconds in the viewfinder for shutter speeds greater
than 2 s. The actual calculated and steplessly controlled
exposure time may vary from the exposure time displayed in half
step increments: if e.g. the display shows 16 (the closest value)
before shutter release, but the calculated exposure time is
longer, then the countdown after shutter release can start from
19.
• Under extreme lighting conditions and based on all the
parameters, the exposure metering may generate a shutter
speed that is outside the focus range, i.e. brightness values that
would require shorter exposures than 1⁄4000 s or longer than 4
min. The camera will use the stated min. or max. shutter speeds
and these values will flash as a warning in the viewfinder if that
is the case.

MANUAL EXPOSURE SETTING – M
The following manual settings for shutter speed and aperture are a
good choice:
– to create a special image mood that can only be achieved with a
very specific type of exposure
– to ensure a perfectly identical exposure for multiple images with
different cropped sections
▸ Sset the desired shutter speed and aperture value
• The shutter speed setting dial must be clicked to one of the
engraved exposure shutter speeds or to one of the intermediate values.
▸ Shutter release

DISPLAY IN THE VIEWFINDER

DISPLAY ON THE LCD PANEL

correct exposure
Under/over exposure by the displayed value

LONG-TERM EXPOSURE (B)
B FUNCTION

In setting B, the shutter remains open as long as the shutter button
is held down (up to max. 16 min depending on ISO setting).
T FUNCTION

When the B function is selected in conjunction with the self-timer
(see 82), then the shutter button doesn’t have to be held down.
The shutter will remain open until the shutter button is pressed
again (the equivalent of a T function). This prevents blurring in
long-term exposures when the shutter button is pressed.
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Underexposure by at least one aperture stop
Underexposure by a 1/2 aperture stop
correct exposure
Overexposure by a 1⁄2 aperture stop
Overexposure by at least one aperture stop

Under or overexposure by more than 3 EV
(Exposure Value)
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FIXED SHUTTER SPEEDS

This function can also be used to permanently set shutter speeds
longer than 8 s.

▸ Set the shutter speed setting wheel to B
▸ Press the focus button for approx 1 s
• The submenu containing the shutter speeds or B is shown in
the display. Available shutter speeds are indicated in white
(may vary depending on ISO sensitivity), those not available
appear in gray.
▸ Select the desired setting
▸ Tap the shutter button
• The setting is applied and the submenu disappears.
• The setting can alternatively be applied via any other button
(except the directional pad).
▸ Shutter release
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Notes
• In each of these cases, the exposure meter remains deactivated;
after shutter release, however, the digital number display in the
viewfinder counts the elapsed exposure time in seconds.
• Long exposure times may cause severe image noise. In order to
reduce this annoying phenomenon, the camera will take a
second “black picture” (taken with the shutter closed) automatically after pictures taken with slow shutter speeds and high ISO
values. The noise metered in this parallel picture is then digitally
“subtracted” from the data for the actual picture. In such cases
the message Noise reduction will appear with a relevant time value.
The doubling of the “exposure” time must be taken into account
for long exposure times. The camera must not be switched off
during that time.

EXPOSURE PREVIEW
You can now assess the effect of the relevant exposure setting on
the image before taking the picture.
There are two assessment methods available.
– Release button half pressed
The brightness of the screen image mirrors the effects of the
selected exposure settings when pressing and holding the
shutter button on the first pressure point. This is displayed as .
At all other times, the display in Live View shows an optimal
exposure setting.
– Hold
The brightness of the screen image matches the exposure
setting. This is displayed as .
▸ Select Capture Assistants in the main menu
▸ Select Exposure Simulation
▸ Select the desired setting
Note
• Depending on ambient lighting conditions, the brightness of the
screen image may differ from that of the actual pictures, despite
the settings described above.

EXPOSURE LOCK
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We often want to arrange important subject elements outside the
center of the picture for reasons of picture composition and these
elements may sometimes be very bright or very dark. Center-weighted metering and spot metering, however, mainly capture
an area in the center of the image and are calibrated to an average
gray scale value. In that case the metering memory lock initially
allows a metering of the main object and to store the relevant
settings until the final image section is set.

Picture mode

EXPOSURE CONTROL

▸ Aim at the important image component (using the metering field
for spot metering) or alternatively at another detail with average
brightness.
▸ Tap the shutter button
• The measurement is taken and saved.
• As long as the shutter button is held at the first pressure
point, a small red dot will appear in the viewfinder at the top in
the number line for confirmation, and the exposure time won’t
change, even if lighting conditions change.
• Pan the camera to capture the final image section while
keeping the shutter button pressed.
▸ Shutter release
Notes
• A metering memory lock doesn’t make much sense in conjunction with multi-field metering, because a targeted capture of an
individual object element will not be possible.
• A change in the aperture setting after the metering memory lock
is set will not result in an adjustment of the shutter speed, i.e.
the end result would be an incorrect exposure.
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EXPOSURE COMPENSATION

Using thumbwheel control

Exposure meters are calibrated for a medium gray scale value,
which matches a standard, i.e. average image object. Should the
measured image detail not fulfill that requirement, then the a
relevant exposure compensation can be effected.
Specifically where several pictures are taken in sequence, for
example if for a series a slightly lesser or greater exposure is
desired for a particular reason, then exposure compensation can
be a very useful function: Once set, the setting remains active – unlike the metering memory lock – until it is reset.
Exposure compensation can be set in the range ±3EV in 1⁄3 EV
increments (EV: exposure value).

▸ Select Customize Control in the main menu
▸ Select Customize Wheel
▸ Select Exposure Compensation

A

A
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Set compensation value (marks at 0 = Off)

▸ Set the desired value using the thumbwheel
Using menu control
▸ Select Exposure Compensation in the main menu
• A scale appears as a submenu item.
▸ Set the value on the scale
Notes
• The following applies for set compensation values, no matter
how they were initially set: They remain effective until they are
manually reset to 0, i.e. even if the camera is switched off and on
again in the meantime. They can be reset using either menu
control or the thumbwheel.
• In case of A, the compensation value is displayed in the
viewfinder, for example 1.0- /0.3 (temporary display instead of
the shutter speed). Then the compensation value is shown in the
form of changed shutter speeds and a flashing dot at the bottom
or for about 0.5 s when the display is activated.
• The set exposure compensation is indicated by a mark on the
exposure compensation scale in the footer line.

PICTURE RECORDING MODES
The camera is set to single shot exposures (Single) by default. Serial
exposures can also be created to e.g. capture motion sequences at
various stages.
▸ Select Drive Mode in the main menu
▸ Select the desired setting
(Continuous Low Speed, Continuous High Speed)
Once you have finalized your settings, the camera will take serial
exposures as long as you keep the shutter button pressed down
fully (and you have sufficient space on your memory card).
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Picture mode

SERIAL EXPOSURES

Notes
• We recommend deactivating the preview review mode
(Auto Review) when using this function.
• The specified picture sequence stated in the technical information refers to a default setting (ISO 200, JPG format L-JPG).
• Regardless of how many pictures were taken in a series, the last
picture in the series or the last picture saved on the memory
card while the save process is ongoing will be displayed first in
both review modes.
• Serial exposures with Continuous High Speed set are taken at a
frequency of max. 4.5 fps, provided shutter speeds of 1/60 s or
faster are used.
• Serial exposures are not possible if a flash is used. Only a single
picture will be taken if the flash function is activated.
• Serial exposures are not available in combination with the
self-timer function.
• The buffer memory of the camera only allows a limited number of
exposures in series and in the selected exposure frequency. The
exposure frequency is reduced, once the capacity limit of the
camera is reached.
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INTERVAL SHOOTING

Picture mode

This camera allows you to capture motion sequences over
extended periods of time automatically using the interval shooting
function. You must specify the interval between shots and the
number of frames in the series.
The exposure and focus settings are no different from those for
normal pictures, but you should remember that the lighting
conditions may change during the course of the picture series.
SPECIFYING THE NUMBER OF PICTURES
▸
▸
▸
▸

Select Drive Mode in the main menu
Select Interval
Select Frames
Enter the desired value

SPECIFYING THE INTERVALS BETWEEN SHOTS
▸
▸
▸
▸

Select Drive Mode in the main menu
Select Interval
Select Interval Time
Enter the desired value

To get started

▸ Press the shutter button
• The remaining time until the next exposure and the number of
pictures taken are displayed at the top right of the image.
To cancel a running serial exposure

▸ Press the MENU button
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Notes
• Interval shooting over an extended period of time in a cold
location or in a place with high temperature and humidity may
result in malfunctions.
• Interval shooting will be interrupted or canceled in the following
situations:
– if the battery is depleted
– if the camera is switched off
Make sure to check the battery for sufficient charge. A warning
will be displayed when the battery reaches a critically low level.
• The interval function remains active after a picture series is
completed, and also after the camera is switched off and on
again, until another exposure mode (picture series) is set.
• The availability of this function does not mean that the camera is
suitable for use as a monitoring device.
• Regardless of how many pictures were taken in a series, the last
picture in the series or the last picture in the series or the last
picture saved on the memory card while the saving process is
ongoing will be displayed first in both review modes.
• We recommend deactivating Live View mode for longer interval
shoots or picture series.

EXPOSURE BRACKETING

A
B
C

▸ Select Drive Mode in the main menu
▸ Select Exposure Bracketing
▸ Select the desired number of pictures in the submenu under
Frames

▸ Select the desired exposure offset in the submenu under F-Stops
▸ Select the desired Exposure Compensation value in the sub menu
• The marked exposure values change positions according to
the settings selected. In the case of exposure compensation,
the scale also shifts.
• The selected exposure compensation value will be applied to
the entire exposure series.
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Picture mode

Many attractive objects are rich in contrast, which means they
have very bright and very dark areas. The image effect can be
dramatically different, depending on which of these areas you
choose to align your exposure with. The automatic bracketing
function in aperture priority mode allows you to produce several
alternatives with graduated exposure values and varying shutter
speeds. You can then select the picture you like best or use
relevant picture editing software to calculate an image with a
particularly broad contrast spectrum (HDR).

You can select the desired number of exposures (3 or 5). The
exposure difference, which can be set via F-Stops, can be up to
3 EV.

▸ Shutter release

D
E
A

Number of pictures
Exposure difference between the pictures
C Exposure compensation
D Light value scale
E Exposure values of the images marked in red
(The scale will be offset by the relevant value if exposure
compensation is set concurrently.)
B
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Notes
•
Appears on the LCD panel if the bracketing function is
activated.
• The picture sequence: underexposed/correct exposure/
overexposure.
• The working range for automatic bracketing may be limited
depending on the available shutter speed/aperture combination.
• With automatic ISO sensitivity control enabled, the sensitivity
calculated by the camera automatically for the raw picture will
also be applied to all other pictures in a series, i.e. the ISO value
will not change during bracketing. This may mean that the
slowest shutter speed specified under Maximum Exposure Time is
exceeded.
• The focus range for automatic bracketing may be limited
(depending on the originally set shutter speed). The specified
numbers of pictures will be taken regardless. Several pictures in
a series may consequently be taken with the same exposure
values.
• The function remains active until another function is selected in
the Drive Mode sub menu. If no other function is selected, another
series of pictures is taken each time the shutter button is
pressed.

SELF-TIMER
The self-timer function allows taking pictures with a preset time
delay. We recommend that the camera is placed on a tripod.
▸ Select Drive Mode in the main menu
▸ Select Self Timer 2 s/Self Timer 12 s
▸ Shutter release
• The remaining time until exposure is counted down on screen.
The self-timer LED at the front of the camera counts down the
delay time.
• A running self-timer delay time can be canceled at any time
by pressing the MENU button and restarted by pressing the
shutter button.
Notes
• In self-timer mode, the exposure value is set just before the
picture is taken.
• The function remains active until another function is selected in
the Drive Mode sub menu.

AUXILIARY DISPLAYS

The grids divide the image frame into multiple fields. They facilitate
picture composition and an exact camera orientation. The grid line
distribution can be adjusted to fit the object.

The Clipping display marks bright or dark areas in the image
lacking definition (bright areas flash in red; dark areas flash in
blue). To adjust these displays to specific conditions or your
compositional ideas, you can specify limit values, i.e. the level of
over/underexposure at which they appear. The Clipping display
therefore offers a very simple and exact means for checking and
adjusting your exposure settings.
F2.8

Picture mode

GRID
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CLIPPING

1/8000 ISO 12500 EV

You can choose one of two grid displays. They divide the frame into
3 x 3 or 6 x 4 fields.
▸ Select Capture Assistants in the main menu
▸ Select Grids
▸ Select the desired setting
(Off, 3x3 Fields, 6x4 Fields)

-3

▸
▸
▸
▸

2

1

0

1

2

3+

12MP

8234

Select Capture Assistants in the main menu
Select Exposure Clipping
Select Clipping Enabled
Select On/Off
• The two other lines are not selectable (= gray) when the
function is deactivated.

Note
• The clipping display always refers to the currently displayed
cropped section.
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SETTING LIMIT VALUES

You can set a threshold value for these displays, i.e. define a value
at what degree of overexposure they will appear, so that you can
adjust these displays to specific conditions or in line with your own
composition ideas.
▸ Select Capture Assistants in the main menu
▸ Select Exposure Clipping

▸ Select Lower Limit
▸ Select the desired value
(0 to 20)
▸ Select Upper Limit
▸ Select the desired value
(200 to 255)
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LEVEL GAUGE
The integrated sensors of the camera show its orientation. These
indicators ensure exact camera orientation along the longitudinal
and transverse axes of critical objects, e.g. architecture.

The longitudinal axis is indicated in zero position by two short lines
in the gray bars to the left and right of the image center.
– in zero position = green
– in tilted position = red

Note
• The camera will switch the aspect of the level gauge autonomously for pictures taken in portrait format.

HISTOGRAM

EN

Histogram represents the brightness distribution in the picture. The
horizontal axis shows the graduated values from black (left)
through gray to white (right). The vertical axis corresponds to the
number of pixels at each brightness level.
This type of rendering allows an additional quick and easy
assessment of the exposure setting.

Picture mode

On screen, the horizon is denoted by a long line across the center
of the image on its transverse axis.
– in zero position = green
– in tilted position = red

▸ Tap and hold the shutter button
• The histogram appears.
Notes
• The histogram is always based on the brightness displayed;
depending on the settings used, it may not represent the final
exposure.
• In picture mode, the histogram should be regarded as a "trend
indicator”.
• The histogram during rendering may differ slightly from the one
during exposure.
• Histogram is available only in full screen mode.
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FLASH PHOTOGRAPHY

ATTACHING THE FLASH UNIT

The camera determines the necessary flash intensity by firing one
or more pre-flashes before taking the actual picture. The main flash
fires immediately after, i.e. during exposure All factors influencing
exposure (e.g. filters, aperture settings, distance to the main
subject, reflective ceilings, etc.) are automatically considered.

▸ Switch off the camera and flash unit
▸ Slide the foot of the flash unit all the way into the accessory
shoe and use the clamping nut (where available) to secure it
against accidental movement
• Movement inside the accessory shoe can interrupt required
contacts and therefore cause malfunctions.

COMPATIBLE FLASH UNITS

DETACHING THE FLASH UNIT

The entire scope of functions described in this instruction manual,
incl. TTL flash metering, is available only for Leica system flash
units like the SF 40. Other flash units, which only have a positive
center contact, can be safely fired via the Leica M10 Monochrom,
but cannot be controlled via the camera. Correct function cannot
be guaranteed when using any other flash unit.

▸ Switch off the camera and flash unit
▸ Detaching the flash unit

Important
• The use of incompatible flash units with your Leica M10
Monochrom may result in irreparable damage to the camera
and/or the flash unit.
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Note
• Make sure that the accessory shoe cover is always in place
when no accessory is attached (e.g. a flash unit).

FLASH EXPOSURE METERING (TTL METERING)

In aperture priority mode and with manual setting, the camera
furthermore allows the use of other interesting flash techniques
like flash synchronization and firing with slower shutter speeds than
the max. sync time.
The camera additionally communicates the sensitivity setting to the
flash unit. The flash unit can use this information to automatically
adjust its range data, provided the device comes with these
displays and the aperture setting selected on the lens is also
entered manually on the flash unit. The ISO sensitivity setting
cannot be altered via the flash unit on system-compatible units,
because the information is received from the camera.

Operating mode
TTL

Automatic camera control

A

Aperture priority

M

The flash exposure must be set to an output level to
match the aperture and shutter speed settings
determined by the camera.

EN

Picture mode

In conjunction with system-compatible flash units (see p. 86),
the camera offers a fully automated flash mode, which is also
available in the auto modes aperture priority and manual setting.

SETTINGS ON THE FLASH UNIT

Set the flash unit to TTL mode to allow automatic control of the
unit by the camera.
When set to A, subjects with above or below average brightness
may not be exposed correctly.
In M mode, the flash exposure must be set to an output level to
match the aperture and shutter speed settings determined by the
camera by setting an appropriate partial light power level.
Note
• Please read the relevant manual provided with third party flash
units regarding their various operating modes.
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HSS (HIGH SPEED SYNC.)
Automatic flash activation at fast shutter speeds

Picture mode

A fully automated, camera-controlled HSS flash mode for all
shutter speeds and all exposure modes is available in the Leica
M10 Monochrom for use with system-compatible flash units (see
p. 86). It is activated by the camera automatically if the selected
or calculated shutter speed is faster than the sync speed (1⁄180 s).
Note
The range for HSS flashes is significantly lower than for TTL
flashes.
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FLASH CONTROL
The settings and functions described in the following sections only
apply to settings and functions available in this camera and in
system-compatible flash units.
SYNC POINT
Flash exposures are lit by two light sources:
– ambient light
– Flash
Any subject elements lit primarily by the flash will almost always be
rendered in perfect focus by the short burst of light, provided the
focus is set correctly. All other subject elements in the same frame
lit by ambient light or lit from within will be rendered with varying
degrees of sharpness. Whether or not these object elements will
be rendered in sharp focus or blurred, as well as the degree of
"blurriness" depends on two interdependent factors:
– the shutter speeds
– the speed of movement of the subject elements or camera
during recording
The longer the shutter speed and the faster the motion, the greater
the difference between the two superimposed partial images.

▸ Select Flash Settings in the main menu
▸ Select Flash Sync. Mode
▸ Select the desired setting
(Start of Exp., End of Exp.)

FLASH RANGE
The usable flash range depends on the aperture and sensitivity
values set manually or calculated by the camera. It is important to
ensure that the subject is within the relevant flash range for
sufficient illumination. A permanent setting to the shortest
available shutter speed for flash mode (sync time) may often result
in unnecessary underexposure of those subject elements that are
not lit sufficiently by the flash.
This camera allows the fine tuning of the shutter speed used in
flash mode in combination with aperture priority depending on the
conditions of the object or your own picture composition ideas.
Factory setting: 1/f

EN

Picture mode

A flash is usually fired at the start of exposure (Start of Exp.), right
after the first shutter curtain has completely opened the image
window. This may result in apparent contradictions, e.g. the picture
of a vehicle being overtaken by its own light trail. This camera
allows you to synchronize the flash firing with the end of exposure
(End of Exp.), right before the second shutter curtain closes the
image window. The sharp image will in this case be a rendering of
the end of the captured motion. This flash technique creates a
more natural impression of movement and dynamics in the image.
This function is available with all camera and flash unit settings.
Factory setting: Start of Exp.

▸ Select Flash Settings in the main menu
▸ Select Max. Flash Sync. Time
▸ Select the desired value
(1/f, 1/(2f), 1/(4f), 1/125 s, 1/60 s, 1/30 s, 1/15 s, 1/8 s, 1/4 s, 1/2 s)

Notes
• Do not use synch cables that are longer than 3 m/10 feet.
• When using the flash with faster shutter speeds, a difference
between the two flash times will be barely discernible or only
noticeable for very fast movements.
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FLASH EXPOSURE COMPENSATION
This function can be used to selectively reduce or enhance flash
exposure regardless of ambient light, e.g. to brighten the face of a
person in the foreground when taking a picture outdoors in the
evening while retaining the same general lighting mood.
Factory setting: 0 EV
▸ Select Flash Settings in the main menu
▸ Select Flash Exp. Compensation
• The sub menu displays a scale with a red setting mark. The
function is deactivated if the value is set to 0.
▸ Set the value on the scale
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Notes
• The following applies for set compensation values, no matter
how they were initially set: They remain effective until they are
manually reset to 0, i.e. even if the camera is switched off and
on again in the meantime.
• Flash Exp. Compensation is not available if flash units with an
integrated compensation function are used, e.g. Leica SF 58.
• A compensation value configured on the camera will be
overruled when a relevantly equipped flash unit is attached, e.g.
a Leica SF 60 and a compensation value is entered on that flash
unit.
• The menu item Flash Exposure Compensation can only be used in
conjunction with flash units on which the correction value
cannot be set manually (e.g. Leica SF 26).
• A brighter flash illumination with Plus compensation will require
a greater flash intensity. Flash exposure compensation will therefore impact on the flash range: A Plus correction will decrease it,
a Minus correction will increase it.
• An exposure compensation set on the camera will only affect
the measurement of ambient light. If a simultaneous TTL flash
exposure metering compensation is desired in flash mode, then
it must be additionally set on the flash unit. (Exception: On the
Leica SF 26, the compensation value must be set on the camera
via menu control.)

▸ Switch on the flash unit
▸ Set the desired guide number control mode (e.g. TTL or GNC =
Guide Number Control) on the flash unit
▸ Switching the camera on
▸ Set the desired exposure mode, shutter speed and/or aperture
setting
• It is imperative to take note of the shortest flash sync speed,
as it determines whether a "normal" flash or an HSS flash is
fired.
▸ Tap the shutter button before each flash exposure to activate
exposure metering
• The flash unit may not fire if this step is missed by pressing
the shutter button down completely and skipping these
settings.
Notes
• A flash unit that is not ready to flash may cause incorrect
exposures or error messages.
• Studio flash systems may have a very long flash firing duration. It
may therefore be advantageous to select a slower shutter speed
than 1⁄180 s when using such a system. The same applies for
RF-controlled flash firing for so-called "off-camera" flashes, as
the transmission time may cause a delay.
• Serial exposures and automatic bracketing with flash are not
available.
• Use a tripod to prevent blurring at slow shutter speeds.
Alternatively, you can select a higher sensitivity.

FLASH EXPOSURE DISPLAYS IN THE VIEWFINDER
(with system-compatible flash units)

EN

The flash icon in the viewfinder display of the Leica M10 Monochrom gives feedback on and indicates various operating states.

Picture mode

FLASH PHOTOGRAPHY

does not appear
(despite the flash unit
being switched on
and ready)

• The flash unit cannot fire
• A correct operating mode must be
set on the flash unit or an HSS-compatible flash unit must be connected

flashes slowly
before the picture is
taken
(2 Hz)

• The flash unit is not yet ready for use

lights up before the
picture is taken

• The flash unit is ready for use

remains continuous- • The flash is still ready
ly lit after shutter
release*
flashes rapidly after
shutter release
(4 Hz)*

• Successful flash photography
• The flash unit is not yet ready for
further use

switches off after
shutter release*

• Flash intensity was insufficient

*only in TTL flash mode
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REVIEW MODE

CONTROL ELEMENTS IN REVIEW MODE
16

There are two completely independent Review functions available:
– short-term rendering directly after exposure (Preview)
– normal Review mode, in which the stored recordings can be
viewed and managed for any length of time
Notes
• Recorded pictures are not automatically rotated in Review mode
to utilize the full screen area.
• It may not be possible to render files with this camera that were
not recorded with this device.
• In some cases, the screen image may not have the expected
quality, or the LCD panel will remain blank and only display the
file name.
• You can toggle back from playback mode to recording mode at
any time by tapping the shutter button.

F2.8

1/8000 ISO 12500 EV
999-9000

18

24

23

19
20
INFO

22:45PM 22.02.2012

12MP

8234/9999

18

LV button

16

Thumbwheel

19

PLAY button

23

Directional pad

MENU button

24

Center button

20

SELECTING/SCROLLING THROUGH RECORDINGS

▸ Press the PLAY button
• The last picture taken appears on the screen.
• The message No media file to display. appears if the inserted
memory card does not contain any picture data.
• The PLAY button function differs, depending on the current
camera setting:

The recordings are visually arranged in a horizontal reel. When the
end of an image series is reached, the display automatically jumps
back to the first image in the series. All recordings can therefore
be reached by scrolling either right or left.

Initial situation
Full screen display of a
recording
Display of an enlarged cropped
section/or several thumbnails

Using touch control
▸ Swipe to the left or right

EN

Review mode

INITIATE/EXIT REVIEW MODE

After pressing the PLAY
button
Picture mode
Full screen display of the
recording

Using button control
▸ Press the directional pad left/right
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INFO DISPLAYS IN REVIEW MODE
With the factory settings in place, recorded pictures will be
displayed without the information in the header and footer lines for
an unobstructed view of the image.
F2.8

1/8000 ISO 12500 EV
999-9000

INFO

22:45PM 22.02.2012

12MP

F2.8

1/8000 ISO 12500 EV

INFO

12MP

8234/9999

Using button control
▸ Press the center button
Note
• The histogram and clipping displays always refer to the currently
shown picture section.

999-9000

22:45PM 22.02.2012

▸ Briefly tap the LCD panel

8234/9999

The configured displays can be accessed at any time. The displays
for Histogram and Clipping will appear if these functions are activated.
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Using touch control

CROPPED SECTION ZOOM
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Review mode

You can zoom in to any section of an image for closer inspection.
You have a four-step zoom factor available via the thumbwheel,
while zooming is stepless if you use touch control.
Using touch control

▸ Swiping will allow you to move the position of an enlarged
cropped section
• The rectangle within the frame in the bottom left corner
represents the currently magnified section, as well as its
position in the image.

▸ Two-finger pinch/spread
• The central cropped section of the picture is enlarged.

▸ Double tap
• Toggles between max. zoom at the tap position and full
screen view.

95

Review mode

EN

Using button control

DISPLAYING MULTIPLE RECORDINGS AT ONCE

▸ Turn the thumbwheel
(to the right: increase magnification, to the left: decrease
magnification)
▸ Press the directional pad to move the cropped section anywhere
in the enlarged image
• The rectangle within the frame in the bottom left corner
represents the currently magnified section, as well as its
position in the image.

The camera offers an overview function in which several thumbnail
images can be viewed on one screen, which makes it easier to find
a specific image. You can choose 12 or 20 images per overview.

OVERVIEW
Using touch control

You can move directly from one picture to the next in magnification
mode, which will then also be displayed with the same magnification.
▸ Press and hold the PLAY button while pressing the directional
pad left/right
Note
• It may not be possible to enlarge pictures taken with other
camera types.

▸ Two-finger pinch
• The display toggles from 12 to 20 thumbnails.
To view other recordings

▸ Swipe up or down
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DISPLAYING RECORDINGS IN BLOCKS OF 20

▸ Turn the thumbwheel to the left
• 12 thumbnails are shown at the same time. Another turn on
the thumbwhell increases the number of pictures to 20.

In this view, you can browse through the blocks easily.

B

936-954

954

C
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Using button control

A

B

954

▸ Reduce the size of the images until the entire field is framed in
red
▸ Press the directional pad left or right as needed
or
▸ Swipe up or down

C

A

A Currently selected recording
B Number of the currently selected recording
C Scrollbar

The currently viewed recording is framed in red and can be
selected for a closer look.
Navigating between recordings

▸ Press the directional pad left or right as needed
97

Review mode

EN

RETURNING TO FULL SCREEN VIEW

TAGGING/RATING OF RECORDINGS

Using touch control

Recordings can be tagged as favorites to find them quicker or to
simplify the later deletion of multiple recordings.

▸ Two-finger spread
or
▸ Briefly touch the image

Notes
• Other recordings can be selected while the Review menu is
active.
• You can exit the Review menu at any time by pressing the MENU
button.

TAGGING RECORDINGS
▸ Press the directional pad up
• The recording is tagged with
or
Using button control
▸ Turn the thumbwheel to the right
or
▸ Press the PLAY button/the center button
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▸ Press the MENU button
▸ Select Rate
• The recording is tagged with

.

.

DELETING RECORDINGS

▸ Press the directional pad down
• The
tag disappears.
or

There are several methods available to delete recordings:
– deleting individual recordings
– deleting all recordings without a tag/ranking
– deleting all recordings

▸ Press the MENU button

▸ Select Unrate

REMOVING ALL TAGS
▸ Press the MENU button
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REMOVING INDIVIDUAL TAGS

Important
• Once deleted, recordings are no longer retrievable.
Notes
• Other recordings can be selected while the Review menu is
active.
• You can exit the Review menu at any time by pressing the MENU
button.

▸ Select Unrate ALL
• The LED will flash during this operation.
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DELETING INDIVIDUAL RECORDINGS

To cancel deletion and return to the normal Review mode

▸ Press the MENU button

▸ Press the PLAY button

Review mode
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Note
• The “Scroll” and “Magnify” functions continue to be available
when the “Delete” screen is active.

▸ Select Delete Single in the Review menu
• The Delete screen appears.

▸ Press the center button
• The LED will flash during the delete process. The process may
take a few seconds.
• The next recording will be displayed once deletion is
complete. The message No media file to display. appears if no
other recordings are saved on the card.
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DELETING ALL RECORDINGS
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Review mode

▸ Press the MENU button

▸ Select Yes
▸ Select Delete Multi in the Review menu

Note
• The LED will flash during the delete process. The process may
take a few seconds. The message No media file to display. appears
after successful deletion.

▸ Select ALL
• The prompt Really delete all? appears.
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DELETING UNRATED RECORDINGS

Review mode

▸ Press the MENU button

▸ Select Delete Multi in the Review menu

▸ Select ALL Unrated
• The prompt Really delete all unrated? appears.
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▸ Select Yes
• The LED will flash during the delete process. The process may
take a few seconds.
• The next marked recording appears once deletion is
complete. The message No media file to display. appears if no
other recordings are saved on the card.

PREVIEW OF LATEST RECORDING

▸ Select Auto Review in the main menu
▸ Select the desired function or duration
(Off, 1 s, 3 s, 5 s, Permanent)

Review mode

Recordings can be displayed automatically directly after they are
taken to e.g. check the success of the recording quickly and easily.
A duration for the automatic display can be configured.
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Permanent: The most recent recording is displayed until automatic
review is ended by tapping the shutter button.

Notes
• Various control elements change back to regular Review mode
to execute their normal functions while automatic review is
selected. The camera will remain in Review mode until it is
exited.
• Tagging and deleting can only be done in regular Review mode
and not during automatic review.
• When pictures were taken with the functions Serial exposures or
Interval shooting, then the last image in the series will be
displayed or – if the save process is still incomplete – the last
image in the series saved to the memory card.
• Where display times were configured (1 s, 3 s, 5 s) automatic
review can be ended immediately by tapping the shutter button.
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OTHER FUNCTIONS

Other functions

USER PROFILES
This camera allows the permanent storage of any menu settings, to
e.g. access them quickly and easily for recurring conditions/image
objects. Six memory slots are provided to store custom settings,
plus the factory setting, which is always available and cannot be
modified (Standard Profile). You can assign names for the saved
profiles yourself.
Any profiles configured for the camera can be saved to a memory
card for use on another camera. Similarly, profiles saved on a
memory card can be transferred to the camera.

SAVING CURRENT SETTINGS AS A USER PROFILE
CREATING PROFILES
Saving settings/Creating a profile
▸ Create custom settings for the desired functions via menu
control
▸ Select User Profiles in the main menu
▸ Select Save as User Profile
▸ Select a memory slot
▸ Confirm the selection
Notes
• Existing profiles are overwritten with the latest settings.
• A memory slot can only be deleted via the function Reset Camera
described in the section "Resetting the camera to factory
settings" (see p. 110).
RENAMING PROFILES
▸
▸
▸
▸
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Select User Profiles in the main menu
Select Rename User Profile
Select a profile
Enter a name for the profile via the associated submenu
keyboard and confirm your input (see p. 51)
• Profile names must be between 3 and 5 characters in length.

APPLY/ACTIVATE PROFILES

EXPORTING/IMPORTING PROFILES TO/FROM THE
MEMORY CARD

▸ Select User Profiles in the main menu
▸ Select Load Profile
• A list of profile names is displayed.

▸ Select User Profiles in the main menu
▸ Select Export to Card or Import from Card in the submenu
▸ Confirm the selection

▸ Select a profile
• The selected profile is marked as active.

Notes
• When importing and exporting, all profile slots are transferred to
the card, i.e. including any empty slots. Any existing profiles
stored in the camera will be overwritten, during the profile
import. Individual profiles cannot be imported or exported.
• Any existing set of profiles will be replaced on the memory card
during an export without an acknowledgment prompt.

Note
• will appear in the original menu list instead of the name of the
profile used if you change one of the settings for the profile
currently in use.
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Factory setting: Standard Profile
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DATA STRUCTURE ON THE MEMORY CARD
FOLDER STRUCTURE
The files (= pictures) on the memory cards are saved in automatically generated folders. The first three characters signify the folder
number (numerals), the last five the folder name (letters). The first
folder is assigned the name "100LEICA", the second "101LEICA". A
folder will always be created with the next available number; you
can have max. 999 folders.
FILE STRUCTURE
The file names in these folders consist of eleven characters. In the
factory settings, the first file is named "L1000001.XXX", the
second "L1000002.XXX", etc. The first letter can be selected, the
"L" from the factory settings denotes the camera brand. The first
three characters signify the folder number (numerals). The next
four digits denote the sequential file number. Once file number
9999 is reached, then a new folder will be automatically created, in
which the file numbering begins at 0001 again. The last three
places after the dot denote the file format (DNG or JPG).
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Notes
• When using memory cards that were not formatted with this
camera, the file numbering will begin with 0001 again. Should
the memory card already contain a file with a higher number,
then numbering will be continued from that number.
• A relevant message will be displayed on the LCD panel once
folder number 999 and file number 9999 are reached, and all
numbering must be reset.
• Format the memory card and reset the picture number right
after to reset the folder number to 100.

CREATING A NEW FOLDER

▸ Select Image Numbering in the main menu
▸ Select Change Filename
• A keyboard submenu is displayed.
• The input line contains the full file name. The four white
numerals in the first group can be changed.

▸ Select Image Numbering in the main menu
▸ Select New Folder
• A keyboard submenu is displayed.
• The input line contains the full folder name. The five white
characters can be modified.

▸ Delete the four selected characters
▸ Enter a new name of your choice (see p. 51)
▸ Confirm

▸ Delete the five selected characters
▸ Enter a name of your choice
▸ Confirm
• A prompt appears. Here you decide if you want the file
numbers in the new folder to start at 0001 again (Yes) or if the
numbering should continue (No).

Note
• The change to a file name applies for all later pictures as well
until a new change is made. The sequential number (second
4-digit group of numerals) will not be affected by the change; it
can, however, be reset by creating a new folder.
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EDIT FILE NAMES

Notes
• A file name change also applies to all subsequent folders or until
another change is made.
• When all user-affected changes are reset, then the folder name
will once again be “XXXLEICA”.

RESETTING IMAGE NUMBERING
▸ Select Image Numbering in the main menu
▸ Select Reset Image Numbering
• A relevant prompt is displayed.
▸ Select Yes/No
Note
The name part of a new folder created using Reset Image Numbering
remains unchanged. The file numbers in the folder will start again
at 0001.
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ADDING COPYRIGHT INFORMATION
This camera allows you to enter letters and other characters as a
copyright mark for your picture files.
You can enter up to 20 characters of information under 2 headings
per picture.
▸
▸
▸
▸

Select Camera Information in the main menu
Select Copyright Information
Activate the Copyright function (On)
Select Information/Artist in the submenu
• A keyboard submenu is displayed.

▸ Enter the desired information (see p. 51)
▸ Confirm
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RECORDING THE IMAGE LOCATION USING GPS
(ONLY IN CONJUNCTION WITH LEICA VISOFLEX)
The GPS (global positioning system) allows the pinpointing of a
receiver anywhere in the world. This function is available only with
Leica Visoflex attached. The camera will then continuously receive
the current GPS data (latitude and longitude, elevation above sea
level) and writes this information into the Exif data of the images.
Please read "Important notes regarding the use of GPS" (see
p. 4) before using this function.
▸ Select GPS in the main menu
▸ Select On/Off
• The “satellite” icon in the top display indicates the current
status:
–
most recent geolocation max. 6 min. ago
–
most recent geolocation max. 24 hrs ago
–
no geolocation data available

FORMATTING A MEMORY CARD

▸ Select Format SD in the main menu
▸ Confirm the selection
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Memory cards that have already been in use with this camera will
usually not require formatting. An unformatted memory card that is
inserted into the camera for the first time must be formatted. We
recommend formatting memory cards from time to time, because
residual data traces (data pertaining to individual pictures) may
reduce the card’s memory capacity.

Notes
• Never switch off the camera while data transfer is in progress.
• All data stored on a memory card will be lost during formatting.
Formatting will not be prevented by the deletion protection set
for individual pictures.
• All images should therefore be regularly transferred to a safe
mass storage medium, e.g. the hard disk of a computer.
• A simple formatting process will initially not irretrievably destroy
existing data on the card. Only the directory will be deleted,
which means the data will no longer be directly accessible. Data
access can be restored with appropriate software. Only data
that is overwritten when new data is saved will actually be
irretrievable.
• A memory card should be formatted again in the camera if it was
formatted in another device, e.g. a computer.
• Contact your retailer or Leica Customer Care if the memory card
cannot be formatted/overwritten (see p. 138).
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DATA TRANSFER

RESETTING THE CAMERA TO FACTORY SETTINGS

Data can be conveniently transferred to mobile devices via Leica
FOTOS (see p. 112). Alternatively, a card reader can be used for
the transfer.

This function allows you to reset all your custom menu settings
back to the factory settings. You can optionally exclude the user
profiles, WLAN settings, and image numbering from the reset
individually.

Note
• We recommend using a card reader for the transfer of large files.

USING RAW DATA (DNG)
You will need specific software for editing data in DNG format, e.g.
the professional raw data converter Adobe® Photoshop® Lightroom®.
It allows high-quality conversions of stored raw data. It furthermore
provides quality-optimized algorithms for digital color processing,
delivering exceptionally low-noise photographs with incredible
resolution. During editing, you can adjust parameters like
gradation, sharpness etc. in retrospect to achieve the best possible
image quality.
You will receive a temporary membership for the Adobe Creative
Cloud Foto subscription with the purchase of this camera. You will
have to register the camera online to take advantage of this
membership:
club.leica-camera.com
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▸ Select Reset Camera in the main menu
• The prompt Reset camera to basic settings? appears.
▸ Confirm or reject the reset to factory settings (Yes) / (No)
• Selecting No will cancel the reset and the display will return to
the main menu. Confirming with Yes will trigger additional
prompts regarding the settings you can opt to keep.
▸ Confirm or reject keeping the user profiles (Yes) / (No)
▸ Confirm or reject keeping the WLAN settings (confirm Yes) /
(reject No)
▸ Confirm or reject keeping the image numbering (Yes)/ (No)
• The camera will be reset.
Notes
• Date & time, as well as the preferred language will have to be set
up again after a reset. Relevant prompts will appear on screen.
• You reset the image file numbering separately via the menu item
Image Numbering (see p. 107)

UPDATING THE CAMERA FIRMWARE

Leica is continuously working on the further improvement and
optimization of your camera. Since many camera functions are
entirely controlled by software, some of these improvements and
additions to the functional scope can be installed in retrospect.
Leica offers firmware updates at irregular intervals, which you can
download from our website.
Leica will notify you of any new updates, once you have registered
your camera.

▸
▸
▸
▸
▸
▸

Find out which firmware version is currently installed

▸ Select Camera Information in the main menu
• The current firmware version is displayed next to the menu
item Camera Firmware.
More information about registering, firmware updates and how to
download them to your camera, as well as any amendments and
additions to this manual can be found in the customer area of our
website at:
club.leica-camera.com

Download the latest firmware version
Save the download to the memory card
Insert the memory card into the camera
Switching the camera on
Select Camera Information in the main menu
Select Camera Firmware
• This menu item is available only if a current firmware file is
stored on the inserted memory card.
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FIRMWARE UPDATES

▸ Select Start Update
• A prompt with information about the camera is displayed.
▸ Check the version information
▸ Select Yes
• The update will start automatically.
• Once the process has completed successfully, a relevant message will be displayed and the camera will restart.
Notes
• The camera must not be switched off before the update is
completed.
• The message Battery low will appear if the battery is not
sufficiently charged. Please recharge the battery and then
repeat the process described above.
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LEICA FOTOS

CONNECTION

The camera can be controlled remotely using a smartphone/tablet
PC. This will require an installation of the Leica FOTOS app on the
mobile device.

FIRST-TIME CONNECTION TO A MOBILE DEVICE

▸ Scan the following QR code with the mobile device

The connection is established via WLAN. A pairing of the camera
and the mobile device is required for a first-time connection to a
mobile device.
IN THE CAMERA
▸ Select Leica FOTOS in the main menu
• The camera will start automatically, once a WLAN network
becomes available. The process may take a few minutes to
complete.
▸ Wait until the QR code appears on the LCD panel

or
▸ The app is available from Apple App Store™/Google Play Store™
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ON THE MOBILE DEVICE

▸ Launch the Leica FOTOS app
▸ Select the camera model
▸ Scan the QR code
• The process adds the camera to the list of known devices.

▸ Launch the Leica FOTOS app
▸ Select the camera model
▸ Confirm the prompt
• The camera connects to the mobile device automatically.

▸ Follow the Leica FOTOS instructions
• The relevant icons appear on the LCD panel once a connection is established successfully.
Notes
• The pairing process may take a few minutes to complete.
• Each mobile device only needs to be paired with the camera
once. The process adds the device to the list of known devices.

Notes
• Should there be more than one known device in the vicinity of
the camera, then it will automatically connect to the first device
responding. A favorite mobile device cannot be specified.
• We recommend removing rarely used devices from the list of
known devices to prevent unwanted connections.
• Disconnect and reconnect if the wrong device was connected.

CONNECTING TO KNOWN DEVICES

SHUTTING OWN THE CONNECTION

IN THE CAMERA

It is recommended to shut down the WLAN provided by the
camera, once a connection to a mobile device is no longer needed.

▸ Select Leica FOTOS in the main menu
▸ Wait until the QR code appears on the LCD panel

▸ Select Leica FOTOS in the main menu
▸ Select Turn WLAN off
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ON THE MOBILE DEVICE

REMOTE CAMERA CONTROL
You can take pictures remotely via the mobile device, and can also
change image settings or transfer data to the mobile device. A list
of available functions and instructions for their use can be found in
the Leica FOTOS app.

113

EN

CARE/STORAGE

Care/Storage

We recommend the following if the camera will not be used for an
extended period of time:
– Switching the camera off
– Remove the memory card
– Remove the battery (after approx. 2 months the set date and
time will be lost)

CAMERA HOUSING
• Keep your equipment meticulously clean, as any kind of dirt
residue presents a breeding ground for micro organisms.
• Only clean the camera with a soft, dry cloth. Stubborn dirt
should first be moistened with a watered-down detergent and
can then be wiped away with a dry cloth.
• Wet a soft cloth with tap water, wring it out thoroughly and use it
to wipe down the camera. Then wipe it down thoroughly with a
dry cloth.
• Wipe the camera with a clean, lint-free cloth to remove stains
and fingerprints. Tougher dirt in hard to reach corners of the
camera housing can be removed with a small brush. Take care
not to touch the shutter blades.
• Store the camera in a closed and padded container to prevent
friction damage and protect it against dust accumulation.
• Keep the camera in a dry, sufficiently ventilated place, where it
will not be subjected to high temperatures and humidity. Make
sure to remove all moisture from the camera if it was used in
humid conditions.
• Do not store the camera in a leather case for extended periods
of time to prevent fungal contamination.
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• Empty you camera bag completely if it ever gets wet during use.
Your equipment might otherwise be subjected to moisture and
tanning residue released by the moist leather.
• All mechanical bearings and sliding surfaces on your camera are
lubricated. Remember to press the shutter button several times
every three months to prevent the lubrication points hardening if
the camera will not be used for an extended period of time. We
also recommend repeated adjustment and use of all the other
operating elements.
• When using your camera in tropical climates, make sure to
expose the equipment to sunlight and fresh air as much as
possible to prevent fungal growth. Storage in airtight containers
or cases is recommended only in conjunction with a desiccant
like silica gel.

LENS
• A soft-bristle brush will usually suffice to remove dust from the
outer lenses. Remove more severe soiling with a clean, soft cloth
that is completely free of foreign matter. Wipe the lens in a circular motion from the center outward. We recommend using
microfiber cloths that come in a protective container and are
available from photography shops and other optical retailers.
These cloths are machine-washable at 40°C. Do not use fabric
softener and do not iron them. Never use spectacle lens
cleaning cloths, as these are soaked in chemicals, which could
damage the glass of the camera lenses.
• Attach a transparent UVA filter for optimal front lens protection
in unfavorable conditions (e.g. sand, salt water spray). Please
remember that the filter may create unwanted light reflections in
some backlight situations and in case of high contrasts.
• Lens caps also protect the lens against accidental fingerprint
smudges and rain.

VIEWFINDER/LCD PANEL
• Switch off your camera and leave it to stand at room temperature for around 1 hour if condensation has formed on or in the
camera. The condensation will disappear, once the camera
temperature has reached room temperature.

RECHARGEABLE BATTERY
• Lithium-ion rechargeable batteries should only be stored
partially charged, i.e. not fully depleted or fully charged. The
camera LCD panel will show the current charge level of the
battery. Charge the battery twice a year for around 15 minutes
to avoid deep discharge in case of very long storage periods.

MEMORY CARDS
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• All mechanical bearings and sliding surfaces on your lens are
lubricated. Make sure to periodically move the focus ring and the
aperture setting ring to prevent seizing if the lens will not be
used for an extended period of time.
• Make sure not to apply too much lubricant to the bayonet and
take particular care not to apply grease to the 6-bit encoding.
Too much lubricant will result in grease residue lodging in the
gap, where dirt will accumulate. The legibility of the code will be
impacted, which may cause malfunctions in digital M models.

• Make sure to store memory cards in their anti-static container
when not in use.
• Do not store memory cards where they will be exposed to high
temperatures, direct sunlight, magnetic fields or static
electricity. Always remove the memory card if the camera will
not be used for an extended period of time.
• We recommend formatting the memory card from time to time,
because fragmented residual data from deleted files may block
some of its storage capacity.
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DUST DETECTION
Any dust or dirt particles stuck to the glass cover of the sensor
may result in noticeable dark stains or specks on the pictures.
Use the Dust Detection function to check if and how much dust is on
the sensor. This procedure is more accurate than a visual check
and therefore a reliable method to find out if cleaning is needed.
▸ Select Sensor Cleaning in the main menu.
▸ Select Dust Detection
• The following message appears:
Please close the aperture to the largest value (16 or 22), and
take a picture of a homogeneous surface (defocussed).

▸ Shutter release
• A “picture” will appear on the display, in which black pixels
represent dust particles.
Note
• A relevant message will be displayed if dust detection is not
available. The display will return to the previous screen after a
few seconds. Repeat the process as needed.
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SENSOR CLEANING
You can send your camera to the Leica Customer Care department
for sensor cleaning (see p. 138). This service is not part of the
warranty offering and will therefore incur charges. Use the
Open Shutter menu function if you feel confident that you can do the
cleaning yourself. The function will keep the shutter open and allow
access to the sensor.
Use clean, possibly ionized gases like air or nitrogen to blow loose
dust from the cover glass of the sensor. We recommend using
(rubber) bellows without a brush. Some specialist, low-pressure
cleaning sprays, e.g. "Tetenal Antidust Professional" can also be
used (follow the instructions provided for the product). Please
contact Leica Customer Care if you are unable to remove the
particles with the methods described above.
Note
• Leica Camera AG will not accept any responsibility for damages
caused by the user when cleaning the sensor.

▸ Select Yes/No
• The rechargeable battery must have at least 60% remaining
capacity for the shutter to open
• A warning message Battery too low for sensor cleaning. will
appear if the battery capacity is lower to indicate that the
function is currently not available and Yes cannot be selected.
▸ Clean the sensor
• Make sure you follow the instructions below.
▸ Switch off the camera after you finish cleaning
• The shutter will remain open for another 10 s for safety
reasons.
• The following message appears:
Please stop sensor cleaning immediately

Important
• Any inspection or cleaning of the sensor should be done in an
environment that is as much as possible dust-free to prevent
further contamination.
• A message will appear on the LCD panel, once the capacity of
the rechargeable battery falls below 40% with the lens aperture
fully open: Please stop sensor cleaning immediately. The shutter will
automatically close when the camera is switched off.
• Make sure that the aperture is unobstructed and that nothing
can prevent the shutter from closing correctly, as this would
result in damage to the equipment!
• Do not attempt to physically blow dust particles off the cover
glass of the sensor. The smallest droplets of saliva can cause
stains that will be difficult to remove.
• Do not use high pressure compressed air cleaners as they may
also cause damage.
• Avoid touching the sensor surface with any hard objects during
inspection and cleaning.
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▸ Select Sensor Cleaning in the main menu.
▸ Select Open Shutter
• Die Message Inspect sensor? appears.
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Problem

possible cause to be verified

Troubleshooting suggestions

Battery issues
Battery is depleted too quickly

Battery too cold

Warm the battery (e.g. in pants pocket) and only insert
directly before use
Allow battery to cool down
Reduce brightness
Activate power save mode
Deactivate WLAN when not in use
Deactivate the function
The battery has reached the end of its operating time
Replace battery
Deactivate Auto Review
Check polarization and connection

Battery too hot
LCD panel or EVF set too bright
Power save mode deactivated
Permanent WLAN connection
Continuous use of LCD panel (e.g. in Live View mode)
Battery has been recharged too many times
Preview of the recorded images (Auto Review) acrivated
Incorrect battery polarization or faulty charger
connection
Charging takes too long
Battery too hot or too cold
Charging pilot light is on, but battery isn't charging The battery contacts are dirty
Battery has been recharged too many times
Charging process not starting

Camera problems
The camera suddenly switches itself off
The camera won’t switch on

Battery is depleted
Battery is depleted
Battery too cold
Battery was inserted incorrectly
Bottom cover was inserted incorrectly
The camera switches off again immediately after it Battery is depleted
is switched on
The camera doesn't respond
The camera is connected to the Leica FOTOS app
Camera does not recognize the memory card
The memory card is not compatible or defective
Memory card is incorrectly formatted
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Charge the battery at room temperature
Clean the contacts with a soft, dry cloth
The battery has reached the end of its operating time
Replace battery
Charge or replace the battery
Charge or replace the battery
Warm the battery (e.g. in pants pocket)
Check its polarization
Check the directionality and lock
Charge or replace the battery
Deactivate when not in use
Replace the memory card
Format the memory card in the camera

The LCD panel is to dark or too bright/not clear
Favorites menu does not appear
Live View stops suddenly or doesn't start

EN
EVF brightness is set too low
The brightness setting is incorrect
Viewing angle is too small
The favorites menu is empty
The camera is hot due to high ambient temperature,
extended Live View operation, extended video recording
or serial exposures
The brightness settings for the LCD panel have no
influence over the exposures
The exposure requires only very little memory space

The brightness in Live View mode is not the same
as in the pictures
The number of remaining exposures does not
count down after a picture is taken
Recording
The camera won’t take a picture/shutter button is Memory card is full
deactivated
The memory card is not formated

The memory card is write protected

No picture is taken

Dirt on the memory card contacts
The memory card is damaged
The sensor is overheating
The camera has switched off automatically (automatic
shutdown)
Picture data is being written to the memory card and the
cache is full
Noise reduction function is working (e.g. after night
photography with long exposure times)
Battery is depleted
Camera is processing a picture
Image numbering has reached its limit.
The camera is connected to the Leica FOTOS app

Set the EVF brightness
Select English in the Language menu
Adjust the display brightness
View it at a perpendicular angle
Add at least one function

FAQ

Menus and displays
Electronic viewfinder is dark
Display language is not English

Allow camera to cool down

Adjust the brightness settings as needed
This is not a fault; the number of remaining exposures
is calculated as approximations
Replace the memory card
Reformat the memory card
(Caution: Loss of data!)
Deactivate the write protection on the memory card
(small lever on the side of the memory card)
Clean the contacts with a soft cotton or linen cloth
Replace the memory card
Allow camera to cool down
Switch the camera on again
deactivate auto shutdown as needed
Wait
Wait or deactivate noise reduction
Charge or replace the battery
Wait
See section "Data Management"
End connection and reconnect

119

FAQ

EN

Image noise appears on the LCD panel/in the
viewfinder when the shutter button is pressed to
the first pressure point
LCD panel/viewfinder deactivates after a very
short time

The gain is increased to aid image composition if the
object is insufficiently lit with reduced aperture opening

Not a fault – picture quality will not be impacted

Power Save settings are activated

Change the settings as needed

The display switches off after the picture is taken/ Flash loads after picture is taken, LCD panel deactivates
the LCD panel goes dark after the picture is taken during load time
Flash won't fire
The flash cannot be used with the current settings
Flash is deactivated
Battery is depleted
Pressing the shutter button while flash is still loading
Automatic bracketing or Picture series is activated
The flash does not fully illuminate the object
Object is outside the flash range
Flash is covered
No continuous recording available
The image on the LCD panel displays lots of noise

The camera is overheated and the function was
temporarily disabled to protect the camera
Light enhancement function of the LCD panel in dark
surroundings

Refer to the list of flash function-compatible settings
Select other flash mode
Charge or replace the battery
Wait until the flash is loaded
Change the setting
Move object into flash range
Make sure the th flash unit is not covered by your finger
or some object
Allow camera to cool down
Not a fault – picture quality will not be impacted

Image storage takes a long time
Electronic viewfinder is dark

Noise Suppression is activated for long-term exposures
Switchover between EVF and LCD incorrectly set

Deactivate the function
Select a suitable setting

Review and image management
Selected images cannot be deleted

Some of the selected images are write protected

File numbering does not start at 1
The time and date settings are incorrect or are not
displayed
The time and date stamp on images are incorrect

The memory card contains previously stored images
The camera has not been in use for an extended period
of time (the battery was removed)
Time settings are incorrect

Remove write protection (using the device with which
the file was originally set to write protected)
See section "Data Management"
Insert a charged battery and configure the correct
settings
Set the time correctly
Caution: Time settings will be lost if the camera is not
used/remains in storage with a depleted battery over
an extended period of time
Cannot be removed in retrospect
Deactivate the function as needed
Change the setting

The time and date stamp on images are unwanted Setting was ignored
Lens information is not displayed

120

Wait until the flash is loaded

Lens Detection is deactivated
The attached lens is not encoded

Contact Leica Customer Service

Pictures/recordings are damaged or missing

Round white stains, similar to soap bubbles
Images are out of focus

Images are overexposed

The image is grainy or there is image noise
Unnatural colors and brightness
No images are displayed

Images cannot be displayed

Never remove the memory card while the readiness
indicator is flashing. Charge the battery.
Reformat the memory card
(Caution: Loss of data!)
Terminate the connection
Change the setting

Light sensor was covered while picture was taken
Long exposure times (>1 s)

Make sure that the light sensor is not obstructed
Activate the noise suppression function for long
exposure times
Decrease ISO sensitivity
Deactivate the flash

ISO sensitivity set too high
Flash photography in very dark environment: Reflection
of dust particles
Lens is dirty
Camera moved during exposure
The desired subject elements were not congruent in the
rangefinder
Flash is activated in bright surroundings
Strong light source in the image
(Half) backlight falling into the lens (also from light
sources outside the image range)
Selected exposure time is too long
ISO sensitivity set too high
Picture taken in artificial light or extreme brightness
No memory card inserted
The recordings are video files or were taken with another
camera
File name of the image was changed on a PC
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Review unavailable
The most recent recording is not displayed
Picture quality
The picture is too bright
Image noise

The memory card was removed while the readiness
indicator was flashing
The memory card formatting is faulty or the card is
damaged
The camera is connected to the Leica FOTOS app
Preview is deactivated

Clean the lens
Use flash or mount camera on a tripod
Ensure perfect congruence of the superimposed
images in the split image rangefinder
Change the flash mode
Avoid strong light sources in picture composition
Use the lens hood or change to another subject
Select a shorter exposure time or turn the shutter
speed setting dial to A
Decrease ISO sensitivity
Try shorter shutter speeds
Insert the memory card
Transfer the recordings to another device to view them
Use appropriate software for image transfers from a PC
to the camera; available from the Leica Camera AG
website
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Smartphones/WLAN
WLAN connection gets interrupted
Cannot pair with a mobile device

Mobile device connection/image transfer not
working

Camera does not appear on the WLAN
configuration screen of the mobile device
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Camera deactivates when it overheats (safety feature)
The camera was already paired with the mobile device

The mobile device is too far away
Interference from other devices in the vicinity, e.g. other
smartphones or a microwave oven
Interference from multiple mobile devices in the vicinity
Mobile device is currently connected to another device
Mobile device does not recognize camera

Allow camera to cool down
Delete the camera registration from the Bluetooth
settings in the mobile device and repeat pairing
process
Bring the devices closer to each other
Increase distance to interfering devices
Re-establish the connection/remove other mobile
devices
Check connection
Switch the WLAN function of the mobile device off and
on again
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MENU OVERVIEW
Main menu

1. Submenu

Factory settings

Available for

FAVORITES

FAVORITES

Menu page 1
l

Lens Detection

l

Drive Mode

l

Interval
Exposure Bracketing

l

Exposure Metering
Exp. Compensation

l

l

Flash Settings

l

l

l

l

Flash Sync. Mode
Max. Flash Sync. Time
Flash Exposure Compensation
ISO Setup

l

M-ISO
Maximum Auto ISO
Maximum Exposure Time
File Format
JPG Settings
JPG Resolution
Contrast
Sharpness
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Toning

l

l

l

l
l

Factory settings

Available for

FAVORITES

FAVORITES

l

Auto Review

l

Capture Assistants
Focus Peaking

Menu overview

Menu page 2
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Histogram
Exposure Clipping
Grids
Exposure Simulation
Focus Aid
Level Gauge

l

EVF/Display Control
Play Screen Target
LV Screen Target
Auto Review Screen Target

l

User Profiles
Load Profile

l

Save as User Profile
Rename User Profile
Export to Card
Import from Card
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Factory settings

Available for

FAVORITES

FAVORITES

l

Customize Control
Edit Favorites
Customize Wheel
LED
Display Brightness

l

EVF Brightness

l

Menu page 3
l

Auto Power Saving

l

Leica FOTOS

l

GPS1

l

Date & Time

l
Auto GPS Time1
Time Zone
Daylight Saving Time
Date Setting
Time Setting

Language

l

Reset Camera

l

Format SD

l
l

Image Numbering
New Folder
Change Filename
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Reset Image Numbering

Factory settings

Available for

FAVORITES

FAVORITES

l

Sensor Cleaning
Open Shutter
Dust Detection

Menu overview

Menu page 4
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l

Camera Information
Camera Firmware
Regulatory Information
Copyright Information

1

This menu item is only available if the Leica Visoflex viewfinder is attached (available as an accessory).
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Index

A
A (Aperture priority).................................................................... 75
Accessory..................................................................................... 3
Adapter....................................................................................... 38
AE-L............................................................................................ 79
Akademie, Leica........................................................................ 140
Aperture..................................................................................... 75
Aperture priority......................................................................... 75
App.......................................................................................... 114
Assist function............................................................................ 69
Auto ISO............................................................................... 46, 73
Automatic review...................................................................... 105
Auto Review.............................................................................. 105
B
Basic picture settings.................................................................. 62
Basic settings, camera................................................................ 58
B function................................................................................... 77
Bluetooth.................................................................................. 114
Brightness, LCD panel................................................................. 60
Brightness, rangefinder............................................................... 60
C
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Camera information.................................................................. 113
Care......................................................................................... 116
Carry strap........................................................................... 10, 30
Center button............................................................................. 47
Center-weighted metering........................................................... 74
Charger.................................................................................. 9, 30
Charge status, charger................................................................ 31

Charge status, LCD panel............................................................ 29
Charging the battery................................................................... 31
Clipping................................................................................ 85, 96
Connection, mobile devices...................................................... 114
Contact. Leica.......................................................................... 140
Contrast, image properties.......................................................... 63
Copyright.................................................................................. 110
Customer service...................................................................... 140
D
Data management..................................................................... 108
Data structure........................................................................... 108
Data transfer............................................................................ 112
Date..................................................................................... 55, 58
Deletion, recordings.................................................................. 101
Deletion, user profiles............................................................... 106
Direct access.............................................................................. 57
Directional pad........................................................................... 47
Display, settings.......................................................................... 59
Disposal........................................................................................ 6
DNG................................................................................... 62, 112
Drive Mode..................................................................... 64, 81, 82
E
Exposure..................................................................................... 74
Exposure bracketing.................................................................... 83
Exposure compensation.............................................................. 80
Exposure compensation, flash..................................................... 92
Exposure lock............................................................................. 79
Exposure, long-term.................................................................... 77
Exposure, manual........................................................................ 76
Exposure metering, flash............................................................. 89
Exposure, metering methods....................................................... 74

G

F

H

Factory settings........................................................................ 112
FAQ.......................................................................................... 120
Favorites................................................................... 127, 128, 129
Favorites, menu.................................................................... 50, 56
Favorites, pictures..................................................................... 100
File format.................................................................................. 62
File name.................................................................................. 109
Firing point, flash........................................................................ 90
Firmware............................................................................ 14, 113
Fixed ISO value..................................................................... 46, 72
Flash........................................................................................... 88
Flash, control.............................................................................. 90
Flash, exposure compensation.................................................... 92
Flash, exposure metering............................................................ 89
Flash, firing point........................................................................ 90
Flash, range................................................................................ 91
Flash, setting.............................................................................. 89
Flash, synchronization................................................................. 90
Flash units, compatible............................................................... 88
Focus button......................................................................... 47, 70
Focusing..................................................................................... 68
Focus metering methods, via rangefinder.................................... 68
Focus peaking............................................................................. 69
Folders..................................................................................... 108
Folder structure........................................................................ 108
Format........................................................................................ 62
Formatting, memory card.......................................................... 111

General information.................................................................... 12
GPS........................................................................................ 4, 58
Grid............................................................................................ 85
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Index

Exposure, modes........................................................................ 75
Exposure preview........................................................................ 79
Exposure simulation.................................................................... 79
Exposure time, max..................................................................... 77

HDR............................................................................................ 83
Histogram................................................................................... 87
Horizon....................................................................................... 86
HSS............................................................................................ 90
I
Image field.................................................................................. 65
Image numbering...................................................................... 108
Image properties......................................................................... 63
Information display...................................................................... 60
Information, regulatory.................................................................. 5
Inserting/removing the battery................................................... 32
Interval shooting......................................................................... 82
ISO Sensitivity....................................................................... 46, 72
ISO value, greatest...................................................................... 73
J
JPG............................................................................................. 62
JPG settings................................................................................ 62
K
Keyboard.................................................................................... 53
L
Language.................................................................................... 58
LCD panel....................................................................... 27, 48, 59
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LCD panel, setting....................................................................... 59
Legal information.......................................................................... 4
Leica Academy......................................................................... 140
Leica Customer Care................................................................ 140
Leica FOTOS......................................................................... 7, 114
Lens............................................................................... 9, 35, 116
Level Gauge................................................................................ 86
Light balance.............................................................................. 76
Live View........................................................................ 67, 69, 74
Long-term exposure.................................................................... 77
M
Magnification, assist function...................................................... 70
Magnification, Playback/Review mode........................................ 97
Magnifying glass......................................................................... 70
Main menu.................................................................................. 51
Main switch................................................................................ 44
Manual exposure setting............................................................. 76
Maximum exposure time............................................................. 77
Memory card.................................................. 10, 13, 33, 111, 117
MENU button.............................................................................. 48
Menu control.............................................................................. 50
Menu language........................................................................... 58
Menu navigation......................................................................... 52
Menu screen............................................................................... 50
Metering method, exposure......................................................... 74
M (Manual exposure setting)....................................................... 76
Multi-field metering, exposure..................................................... 74
N
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Name, file......................................................................... 108, 109
Name, folder............................................................................. 108
Navigation, menu........................................................................ 52

Noise reduction.......................................................................... 77
Notes, legal................................................................................... 4
Number pad................................................................................ 53
O
Operating mode, exposure.......................................................... 75
P
Part Designations........................................................................ 22
Parts, overview........................................................................... 22
Picture, interval........................................................................... 82
Picture mode.............................................................................. 64
Picture series.................................................................. 81, 82, 83
Picture, series............................................................................. 81
Review, automatic..................................................................... 105
Review mode.............................................................................. 94
PLAY button................................................................................ 48
Power off, automatic................................................................... 59
Power save................................................................................. 59
Power save mode........................................................................ 59
Problems.................................................................................. 120
Profile, user.............................................................................. 106
Q
Quick access.............................................................................. 56
R
Rangefinder.......................................................................... 65, 74
Rating, recording....................................................................... 100
Raw data.................................................................................. 112
Rechargeable battery, capacity.................................................... 29
Rechargeable battery, notes............................................ 9, 12, 117

S
Safety remarks.............................................................................. 8
Saving, energy............................................................................ 59
Scale.......................................................................................... 54
Scope of delivery.......................................................................... 2
SD card.......................................................... 10, 13, 33, 111, 117
Self-timer.................................................................................... 84
Sensitivity, ISO...................................................................... 46, 72
Sensor.......................................................................... 10, 13, 118
Sensor cleaning........................................................................ 118
Serial exposures......................................................................... 81
Service..................................................................................... 140
Settings, store.......................................................................... 106
Sharpness, image properties....................................................... 63
Shutter button............................................................................ 45
Shutter release........................................................................... 45
Shutter speed/aperture combination.......................................... 75
Shutter speed setting dial............................................................ 46
Smartphone.............................................................................. 114
Split image method..................................................................... 68

Spot metering, exposure............................................................. 74
Standby mode............................................................................. 59
Status screen.............................................................................. 57
Storage..................................................................................... 116
Submenu.................................................................................... 51
Superimposed image method...................................................... 68
Switching, mode......................................................................... 95
Switching off, camera................................................................. 44
Switching on, camera.................................................................. 44
Sync point.................................................................................. 90
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Index

Recording, delete...................................................................... 101
Recording, marking................................................................... 100
Recording, rating....................................................................... 100
Regulatory information.................................................................. 5
Remote control......................................................................... 115
Repair....................................................................................... 140
Replacement parts........................................................................ 3
Reset, camera........................................................................... 112
Reset Camera........................................................................... 112
Reset, image numbering............................................................ 109
Reset Image Numbering............................................................ 109
Resolution................................................................................... 62

T
Tagging, recordings................................................................... 100
Technical Data.......................................................................... 136
T function................................................................................... 77
Thumbwheel............................................................................... 47
Time..................................................................................... 55, 58
Time lapse.................................................................................. 82
Time zone................................................................................... 58
Toning, image properties............................................................. 63
Touch control.............................................................................. 49
Transfer, data............................................................................ 112
Troubleshooting........................................................................ 120
TTL metering......................................................................... 88, 89
U
Update, firmware................................................................ 14, 113
User-defined operation................................................................ 56
User profiles............................................................................. 106
V
Viewfinder.................................................................................. 26
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Warranty..................................................................................... 15
Wi-Fi/WLAN................................................................................. 7
WLAN........................................................................................... 7
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Designation
Leica M10 Monochrom
Camera type
Digital camera with rangefinder system
Type no.
6376
Order No.
20 050
Buffer memory
2 GB/10 sequential recordings
Storage medium
SD cards up to 2 GB/SDHC cards up to 32 GB/SDXC cards up to 2 TB
Material
Top cover and bottom cover: brass, black chrome-plated finish
Front and rear housing panels: magnesium
Lens mount
Leica M bayonet with additional sensor for 6-bit encoding
Compatible lenses
Leica M lenses, Leica R lenses via adapter
Operating conditions
0 to +40 °C
Interfaces
ISO accessory shoe with additional control contacts for Leica flash
units and Leica Visoflex viewfinder (optional accessory)
Tripod thread
A 1⁄4 DIN 4503 (1⁄4”) with stainless steel in the base

Dimensions (WxHxD)
139 x 38.5 x 80 mm
Weight
approx. 675 g (with battery)
SENSOR
Sensor size
Monochrome CMOS chip, active surface approx. 24 x 36 mm
Processor
Leica Maestro II
File formats
DNG™ (raw data, loss-free compression), JPG
Resolution
DNG™: 7864 x 5200 pixels (40.89 MP)
JPG: 7840 x 5184 pixels (40.64 MP), 5472 x 3648 pixels (20 MP),
2976 x 1984 pixels (6 MP)
File size
DNG™: 40-60 MB, JPG (40 MP): 10-20 MB (depending on resolution
and image content)
Color depth
DNG™: 14 bit
JPG: 8 bit
Color space
Foto: sRGB

EN

SHUTTER

Design principle

Shutter type
Metal blade focal plane shutter with vertical movement
Shutter speeds
With aperture priority set: (A) continuous between 16 min and
1⁄4000 s, with manual setting: between 8 s and 1⁄4000 s in half
increments, between 8 s and 16 min in full increments, B: for long
exposures up to 16 min (in conjunction with self-timer T function, i.e. 1.
shutter release = aperture opens, 2. shutter release = aperture closes),
(1⁄180 s): shortest shutter time for flash synchronization, HSS linear
flash mode with all shutter speeds below 1⁄180s available (with
HSS-compatible Leica system flash units)
Shutter button
Two-step (1. step: Activation of the camera electronics including
exposure metering and metering memory lock (in aperture priority
mode); 2. step: firing)
Self-timer
Delay time: 2 s or 12 s
Drive Mode

Large, bright-line rangefinder with automatic parallax compensation

Eyepiece
Suitable for -0,.5 dpt; optional corrective lenses available: -3 to +3 dpt
Display
Four-digit digital display with items show on the top and bottom
Image field limiter: two lit frames: 35 mm + 135 mm, 28 mm + 90 mm,
50 mm + 75 mm (automatic switch-over when lens is attached)
Parallax compensation
The horizontal and vertical difference between viewfinder and lens is
compensated automatically in line with the relevant focus setting
Congruence of viewfinder and actual image.
The size of the bright-line frame matches the distance:
– at 2 m: the exact sensor size of approx. 23.9 x 35.8 mm
– at infinity: (depending on focal length) approx. 7.3% (28 mm) to 18%
(135 mm)
– less than 2 m: less than sensor size
Magnification
x0.73 (all lenses)
Large-base rangefinder
Split or superimposed image rangefinder shown as a bright field at the
center of the viewfinder image
Actual metering basis
50.6 mm: 69.31 mm (mechanical metering basis) x x0.73 (viewfinder
magnification)
LCD panel
3” TFT LCD, 1,036,800 dots, touch control available

Technical Data

RANGEFINDER/LCD PANEL

Single
Continuous Low Speed
Continuous High Speed

approx. 2.5 fps
approx. 4.5 fps

Interval
Exposure Bracketing

FOCUSING
Working range
70 cm to infinity
Focus Mode
Manual: (focus assist functions Magnification and Focus Peaking
available)
135
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EXPOSURE
Exposure metering
TTL (exposure metering through the lens), with working aperture
Metering principle/method
When measuring the light reflected by the light blades of the 1. shutter
curtain onto a measuring cell: strongly center-weighted; when
measuring on the sensor: Spot metering, center-weighted measurement, multi-field metering
Exposure modes
Aperture priority mode (A): automatic shutter speed control with
manual aperture preselection
Manual (M): manual setting for shutter speed and aperture
Measuring range
At room temperature and normal humidity for ISO 200 at aperture 1.0
EV -1 to EV 19 at aperture 32
Flashing of the left triangular LED in the viewfinder indicates values
below the metering range
Exposure Compensation
± 3 EV in 1⁄3 EV increments
Automatic bracketing
3 or 5 exposures, up to ±3 EV, in 1⁄3 EV increments
ISO sensitivity range
Auto ISO: ISO 200 to ISO 100000
ISO 160 to ISO 100000
FLASH EXPOSURE CONTROL
Flash unit connector
Via accessory shoe with central and control contacts
Synchronization
Optionally at the 1. or 2. shutter curtain
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Flash sync time
: 1⁄180 s, slower shutter speeds available, automatic changeover to
TTL linear flash mode with HSS-compatible Leica system flash units if
sync time is undercut
Flash exposure metering
Using center-weighted TTL pre-flash metering with Leica flash units
(SF 40, SF 64, SF 26), or flash units compatible with the system with
SCA3502 M5 adapter
Flash measuring cell
2 silicon photodiodes with converging lens in the base of the camera
Flash exposure compensation
± 3 EV in 1⁄3 EV increments
Displays in flash mode (in the viewfinder only)
Flash Exposure Compensation via the flash icon LED
EQUIPMENT
WLAN
WLAN function for connection to the Leica FOTOS app. The Leica app
is available from the Apple App Store™ or the Google Play Store™.
Complies with IEEE 802.11b/g/n standard (standard WLAN protocol),
channel 1-11, encryption method: WLAN-compatible WPA™/WPA2™,
access method: infrastructure mode
GPS
Only with Leica Visoflex viewfinder attached (optional accessory)
Optional, not available everywhere due to country-specific legislation.
Data is written to Exif header of the picture files
Menu languages
English, German, French, Italian, Spanish, Russian, Japanese, Simplified
Chinese, Traditional Chinese, Korean, Portuguese

POWER SUPPLY
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Technical Data

Rechargeable battery (Leica BP-SCL5)
1 lithium-ion rechargeable battery, rated voltage 7.4 V; capacity
1100 mAh, max. charging voltage/current: 1000 mADC, 7.4 V;
operating conditions (in the camera): +0 to +40°C; manufacturer: PT.
VARTA Microbattery, Made in Indonesia
Charger (Leica BC-SCL5)
Inputs: 100-240 VAC, 50/60 Hz, 300 mA with automatic switch-over
or 12 VDC, 1.3 A; output: DC, rated voltage 7.4 V, 1000 mA / max.
8.25 V, 1100 mA; operating conditions: +10 to +35°C; manufacturer:
Guangdong PISEN Electronics Co. Ltd., Made in China
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LEICA CUSTOMER CARE

Leica Camera AG
Leica Customer Care
Am Leitz-Park 5
35578 Wetzlar
Germany

Leica Customer Care

Please contact the Customer Care department of Leica Camera AG
for the maintenance of your Leica equipment and for help and
advice regarding Leica products and how to order them. You can
also contact the Customer Care department or the repair service
provided by your regional Leica subsidiary for repairs or warranty
claims.
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Phone: +49 (0)6441 2080-189
Fax: +49 (0)6441 2080-339
Email: customer.care@leica-camera.com
www.leica-camera.com

LEICA ACADEMY
Have a look at our full seminar program with many interesting
workshops on the topic of photography at:
us.leica-camera.com/Leica-Akademie/Global-Leica-Akademie
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